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Welcome
1.0  Welcome
Open Graphic Navigator, also known as OpenGN, is a fire alarm and asset protection 
management and warning system that lets you monitor remote sites located anywhere in the 
world.

This manual instructs you how to install and use the application and explains the 
responsibilities of the administrator and operator.

This chapter contains the following sections:

• Introducing OpenGN

• Configurable Features

• Components

• Installed Software

• User Groups

• Related Documents

Note: Mircom Group of Companies (MGC) periodically updates panel firmware and 
software to add features and correct any minor inconsistencies. For information 
about the latest software, visit the OpenGN website at 
www.mircom.com/OpenGN

i

LT-1113 Rev 3.4.1 9 (139)



Welcome
1.1  Introducing OpenGN

The OpenGN software application provides monitoring, control and software management 
solutions for the fire detection and asset protection market. It lets you monitor information from 
panel-controlled fire detection objects using a customized graphical display. OpenGN also 
stores all events in a log file.

OpenGN addresses the need for an easy-to-use real-time fire monitoring system and provides 
the administrator with a visually pleasing fire detection configuration utility for use in industrial 
and residential establishments.

You set up OpenGN by exporting a job file from the FACP Configurator, and then importing it 
into OpenGN, as shown in Figure 1.

Figure 1 illustrates a typical OpenGN application over a TCP/IP network. For additional 
examples of network topology see Appendix C on page 108.

Figure 1    OpenGN TCP/IP Network Diagram

1.2  Configurable Features

OpenGN is an advanced fire detection and asset protection system that lets you monitor 
information from panel-controlled fire detection objects using a customized graphical display. 
OpenGN also stores all received events in a log file that can be viewed within the application.

Features of the OpenGN product suite include:

• An aesthetically pleasing, high quality, customizable graphical interface that 
administrators can use to monitor buildings or groups of buildings.

Note: Detection Objects are both the physical detectors in the field and the virtual 
devices in the OpenGN program. The fire monitoring panels are physical objects 
with a virtual counterpart in OpenGN. The OpenGN Gateway and the OpenGN 
application are software programs.

i

Devices Nodes

Master

OpenGN

OpenGN 
Gateway

FACP 
Configurator

Export file from 
FACP Configurator

Import file to 
OpenGN

Ethernet 
switch
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• A building ready monitoring control system with full software management in a user 
friendly graphical enabled interface.

• Easy configuration and customization of alarm objects.

• A display of the alarm location on the floor plan with specific information. User actions 
and events are logged and recorded for creation of customized reports.

• OpenGN authenticates the data source as well its sent data.

1.3  Components

The OpenGN fire monitoring system consists of the following components:

1.3.1  Objects

Objects are all the fire device, system points, switches, and custom objects connected to the 
Fire Alarm system. OpenGN assigns properties to objects to help define them, monitor, and 
control them. Objects connect to the panel or node using circuits (loops) and which are defined 
by their state and configuration.

Loops

Each CPU has several circuits where physical objects are placed.

State

All objects can have any of the following states (this is not a complete list):

Function

Input Objects can have the following functions (this is not a complete list):

1.3.2  Node

A node is a Fire Alarm Control Panel such as FleX-Net™.

1.3.3  OpenGN Gateway

The OpenGN Gateway runs on either the same computer as OpenGN or on a separate 
computer on the same network. It is a software application that connects to a node and sends 
information to OpenGN.

Note: The control functions of OpenGN Phase II have not been submitted to UL for 
certification. You may want to use control functions during testing, or when the 
system is in maintenance mode when there are qualified personnel present. 
However, if you require OpenGN to control the Fire Alarm Control Panel during 
normal operation, use the fully listed OpenGN Phase I.

•  Active •  Bypassed •  Trouble

•  Normal

•  Alarm •  Trouble •  Supervisory

•  Monitor

i
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1.3.4  Panel Configurator
The Configurator is a software application that produces the job file for use by OpenGN.To 
connect the Fire Alarm Control Panel with OpenGN, the administrator must export a job file 
from the Configurator and import it into OpenGN. This procedure varies depending on the type 
of panel. In some cases an XML conversion tool is required. See section 1.6 on page 13.

1.3.5  OpenGN

OpenGN is the software application which receives event information from the Fire Alarm 
Control Panel through a TCP/IP port or an Ethernet connection. It allows the user to monitor 
the entire campus in 2D or 3D by building or by floor. A list of all active events from any object 
connected to the panel is displayed here.

1.4  Installed Software

When you run the OpenGN installer, the following software is installed.

1.5  User Groups

OpenGN allows user groups with different privileges. The three default user groups are 
described below. The administrator can change the permissions of these groups and create 
new groups.

1.5.1  Concierge

Members of the concierge group can:

• Monitor status and alarm information.

• Acknowledge alarms.

• Print the logs.

Note: Verify with MGC that your Fire Alarm Control Panel Configurator is compatible 
with OpenGN.

Note: Do not remove or modify any of this software or the files in the locations shown in 
Table 1, or OpenGN might stop functioning.

Table 1  Installed Software

Software Location

OpenGN C:\Program Files (x86)\Mircom Group of Companies

SQL Server (database server) C:\Program Files\Microsoft SQL Server

Codemeter (for licensing) C:\Program Files (x86)\CodeMeter

Crystal Reports (for report 
generation)

C:\Program Files (x86)\Business Objects

i

i
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• Send commands to the panel.

1.5.2  Technician

Technicians can:

• Perform all of the concierge functions.

• Acknowledge and restore all events.

• Exit OpenGN.

• Configure floor plans (add, modify, delete).

• Configure objects (add, modify, delete).

• Configure alarm objects and events (add, modify, delete).

• Change application settings.

1.5.3  Administrator

Administrators can:

• Perform all of the technician functions.

• Assign permissions to roles and users.

1.6  Related Documents

Refer to these documents for instructions on how to connect various types of Fire Alarm 
Control Panels to OpenGN.

• LT-6622 OpenGN to FleX-NetTM Connection Instructions

• LT-6620 OpenGN to PRO-2000 Connection Instructions

• LT-6055 OpenGN to MR-2200/2900 Connection Instructions

• LT-1105 OpenGN to FX-2000 Connection Instructions
LT-1113 Rev 3.4.1 13 (139)
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2.0  Installation
This chapter describes how to install OpenGN and the OpenGN Gateway, and how to 
configure the OpenGN Gateway computer.

For instructions on connecting OpenGN to specific panels, see the following documents on the 
mircom.com website:

• LT-6620 OpenGN to PRO-2000 Connection Instructions

• LT-6055 OpenGN to MR-2200/2900 Connection Instructions

• LT-6622 OpenGN to FleX-NetTM Connection Instructions

• LT-1105 OpenGN to FX-2000 Connection Instructions

This chapter explains

1. Verifying Installation Requirements

2. Installing OpenGN and the OpenGN Gateway

3. Configuring the OpenGN Gateway Computer

4. Configuring OpenGN and the OpenGN Gateway

5. Setting up OpenGN
14 (139) LT-1113 Rev 3.4.1



Installation
2.1 Overview

This chapter describes how to set up the following components:

• OpenGN installed on a computer with TCP/IP network access.

• The OpenGN Gateway connected to the Fire Alarm Control Panel. The OpenGN 
Gateway can be installed on the same computer as OpenGN, or on a separate 
computer.

2.2 Verifying Installation Requirements

The recommended requirements for OpenGN are:

• STANDARD

• Intel Dual Xeon E5-2609V4 /w one processor

• 8GB of RAM

• 1 X 2TB of DISK /w NO RAID

• AMD FirePro W5000 DVI graphics card

• Windows 7 Pro 64-bit

• ENTERPRISE for Redundancy

• Intel Dual Xeon E5-2609V4 /w two processors

• 8GB of RAM

• 4 X 2TB of DISK /w RAID 10

• AMD FirePro W5000 DVI graphics card

• Windows 7 Pro 64-bit

If the OpenGN Gateway is installed on a separate computer, contact your MGC representative 
for the recommended requirements.

2.3 Upgrading OpenGN

If you are upgrading an earlier version of OpenGN to version 3.4, you must upgrade to version 
3.2 first. You cannot upgrade from a version earlier than 3.2.

Attention: Verify that the Configurator version is compatible with OpenGN.!
LT-1113 Rev 3.4.1 15 (139)
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2.4 Installing OpenGN and the OpenGN Gateway

To install OpenGN

1. Do one of the following:

• From the USB key:

a. Insert the USB key into the computer.

b. Double-click the OGN-Client icon.

• From the downloaded file:

a. Double-click the downloaded file to extract it.

b. Double-click the OGN-Client icon in the extracted folder.

• If you see a message asking you to install additional software, always choose to install it.

2. On the first screen, click Install.

Figure 2    Install Screen

The OpenGN Welcome screen appears.

Note: To meet agency requirements, you must install OpenGN in the same room as the 
MGC Fire Alarm Control Panel that it is connected to. In addition, OpenGN must 
be networked via Ethernet within 18 meters (60 feet) to the MGC Fire Alarm 
Control Panel.

Attention: You must be logged in as an administrator when you install OpenGN.

i

!
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3. Click Next.

Figure 3    Welcome to the MGC OpenGN Setup Wizard

4. Select the checkbox to accept the agreement, and then click Next.

Figure 4    End-User License Agreement
LT-1113 Rev 3.4.1 17 (139)
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5. In the Choose Setup Type window, click Typical.

Figure 5    Choose Setup Type

6. Click Install.

Figure 6    Ready to Install OpenGN

Note: If you want to install only OpenGN without the OpenGN Gateway, or only the 
OpenGN Gateway without OpenGN, go to Appendix I - Installing and Uninstalling 
OpenGN on page 131.i
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OpenGN is installed.

Figure 7    Installing MGC OpenGN

7. Click Finish.

Figure 8    Completed the MGC OpenGN Setup Wizard

This procedure places 2 icons on your desktop: Open Graphic Navigator and Open 
Graphic Navigator Gateway.
LT-1113 Rev 3.4.1 19 (139)
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2.5 Configuring the OpenGN Gateway Computer

The OpenGN Gateway is an application that connects to the Fire Alarm Control Panel and 
sends information to OpenGN. The OpenGN Gateway runs on the same computer as 
OpenGN or on a separate computer on the same network. The computer that the OpenGN 
Gateway is running on must be connected to the Fire Alarm Control Panel.

Follow these instructions to assign a static IP to the computer that the OpenGN Gateway is on.

1. On the computer that the OpenGN Gateway is on, click Start, then click Control Panel.

2. Click Network and Sharing Center.

3. Double-click Local Area Connection.

The Local Area Connection Status window appears.

Figure 9    Local Area Connection Status

4. Click Properties.
20 (139) LT-1113 Rev 3.4.1
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The Local Area Connection Properties window appears.

Figure 10    Local Area Connection Properties

5. Double-click Internet Protocol Version 4 (TCP/IPv4).

The Internet Protocol Version 4 (TCP/IPv4) Properties window appears.

Figure 11    Internet Protocol Version 4 (TCP/IPv4) Properties

6. Click Use the following IP address.

7. Type the IP address, subnet mask and default gateway.

If you need assistance, contact your network administrator.

If you are connecting the OpenGN Gateway computer to a FleX-NetTM panel directly 

over Ethernet, enter an IP address that is different than the IP address of the FleX-NetTM 

panel. Enter the same subnet mask as the subnet mask on the panel.

See LT-6622 “OpenGN to FleX-NetTM Connection Instructions” for instructions on how to 

get this information from the FleX-NetTM panel.

8. Repeat these steps for the computer that OpenGN is installed on, if it is a different 
computer.
LT-1113 Rev 3.4.1 21 (139)
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2.6 Configuring OpenGN and the OpenGN Gateway

The method for configuring OpenGN and the OpenGN Gateway depends on the panel that 
OpenGN is connecting to. For instructions, see the following documents on the mircom.com 
website:

• LT-6620 OpenGN to PRO-2000 Connection Instructions

• LT-6055 OpenGN to MR-2200/2900 Connection Instructions

• LT-6622 OpenGN to FleX-NetTM Connection Instructions

• LT-1105 OpenGN to FX-2000 Connection Instructions

2.7 Setting up OpenGN

The following steps can be performed any time after installing OpenGN.

2.7.1  Creating a Campus

A campus is a collection of buildings. You must create a campus before you create a building 
and import a floor plan.

1. Insert your OpenGN Codemeter key into the computer.

2. Double-click the Open Graphic Navigator icon on the desktop.

3. In OpenGN, click the Config button from the Main Display window, and then click Yes to 
go to the configuration section.

4. Click Settings > Campus Settings.

5. Click Update Campus Plan in the Campus Settings window.

The Campus Plan Properties window appears.

Figure 12    Campus Plan Properties

Note: If you have one building, you still need to create a campus and upload a campus 
plan.i
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6. Click Select Campus Plan.

7. Browse to your Campus Plan image file, select it, and then click Open.

8. Click OK to return to the Campus Settings window.

9. Type the information for your campus in the Campus Information section.

2.7.2  Adding a Building

A building consists of one or more floors, each of which has a floor plan. You must create a 
building before you can add floor plans.

1. In OpenGN, click the Config button from the Main Display window, and then click Yes to 
go to the configuration section.

2. Click Settings > Campus Settings.

3. In the Buildings area, click New.

The Building Properties window appears.

Figure 13    Building Properties

4. Type a name for the building.

5. Click OK.

2.7.3  Adding a Floor Plan

After you have added a building, you can assign a floor plan to each floor. See 4.3.1 on 
page 56 for the list of support floor plan file formats.

1. In OpenGN, click the Config button from the Main Display window, and then click Yes to 
go to the configuration section.

2. Click Settings > Campus Settings.

3. Click New in the floor plan area.
LT-1113 Rev 3.4.1 23 (139)



Installation
 The Floor Properties window appears.

Figure 14    Floor Properties

4. Provide the following floor property information:

5. Click Select Floor Plan, then browse to the file location, and then click Open.

A preview image of the floor plan appears.

6. Click OK.

7. Click Close.

2.7.4  Placing a Building

• Click the Campus View  button at the top of the Configuration window.

By default, the building you just added is in the center of the campus.

• Click and drag a building to move it on the campus.

• Click and drag the edge of a building to change its size.

• Click and drag the corner of a building to rotate it.

Description A description of the floor.

Translate X Reserved for future use.

Translate Y Reserved for future use.

Width Reserved for future use.

Height Reserved for future use.

Scale Reserved for future use.

Note: OpenGN automatically stacks the floor plans based on their dimensions. If the 
buildings are irregularly shaped, you must take their size and location into 
account when you convert the files.

Note: Only the top 6 buildings are visible in the Campus View. However, all the 
buildings are visible in Surveillance mode. To place more than 6 buildings, see 
Appendix F on page 116.

i

i
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2.7.5  Placing Objects

Adding objects to a map provides you with an accurate visual representation of the 
surveillance Area and allows you to effectively monitor the location. Unplaced objects are red 
in the Job Tree, and placed objects are green. When OpenGN is connected to the Fire Alarm 
Control Panel, all objects show alarm events whether they are on the floor plan or not.

You can place objects on the floor plan, change their description, and change their Take Action 
Message.

To place objects

1. In OpenGN, click the Config button from the Main Display window, and then click Yes to 
go to the configuration section.

2. Select the building and floor plan where you want to add the objects.

3. Right-click an object in the Job Tree, and then click Place Selected Fire Objects.

The object appears at the top of the Map Area.

4. Drag the object to a location on the floor plan.

To define or change an object description

1. Right-click an object in the Job Tree, and then click Modify Fire Object Description.

2. Type a unique description for the object.

To enter or change a Take Action Message

1. Right-click an object in the Job Tree, and then click Modify Fire Object Take Action 
Message.

The Take Action Message window appears.

Figure 15    Take Action Message

Note: It is your responsibility to ensure that the objects are placed accurately on the 
floor plan.i
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2. Type the Take Action Message. The message should be instructions that the operator 
needs to take when this object is active.

3. Click OK.

Congratulations! You have successfully installed OpenGN.
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3.0  Navigating OpenGN
This chapter provides an overview of the layout and functions of the Main Display and 
Configuration windows of OpenGN.

This chapter explains

• The Main Display Window

• The Configuration Window

• Navigating the Surveillance Area

• Using the Event Log

• OpenGN Gateway
LT-1113 Rev 3.4.1 27 (139)
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3.1 Starting OpenGN

To launch OpenGN

• Do one of the following:

• Double-click the shortcut on your desktop

• Click Start > All Programs > Mircom Group of Companies > Open Graphic 
Navigator > OpenGN

• Browse to the location where the application was installed, and then double-click 
OpenGN.

In Windows 7 64 bit, the default location is
C:\Program Files (x86)\Mircom Group of Companies\Open Graphic Navigator

3.1.1 Log in to OpenGN

You must log in to OpenGN every time you start it.

To log in to OpenGN

1. Select the user from the Login menu.

2. Type the password.

Figure 16    Login Window

Attention: Before starting OpenGN, insert your CodeMeter USB key into a USB 
port of the computer that is running OpenGN. Failure to do so will cause 
OpenGN to run in a limited functionality demo mode. 

Do not remove the USB key while OpenGN is running. Issues arising 
from doing so will not be supported.

Note: If you are starting OpenGN for the first time, the password is blank.

!

i
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3. Click OK.

The Main Display window appears.

3.2 Main Display Window

Figure 17 shows the different areas of the Main Display window.

Figure 17    Main Display window

Note: You can change your password only after you have logged into OpenGN.

System Status Displays status information such as the connection state and operation progress.

Building Selection Cycles through the buildings in the campus.

Floor Selection Cycles through the floors of the selected building, the Control Switches, and the 
Unplaced Devices.

Main Functions Contains the Exit, About, Login, Config and Event Log buttons. See Table 2.

View Options Changes how the information appears in the Surveillance Area. The options are 
Switches, Network, 2D View, Building View, Campus View and Auto-watch 
View. See Table 3.

Surveillance Area Displays a close-up of the selected building or floor plan.

Refresh If your CodeMeter USB key is not inserted in a USB port of the computer that is 
running OpenGN, insert it and then click Refresh.

Attention: Do not remove the USB key while OpenGN is running. Issues 
arising from doing so will not be supported.

i
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3.2.1 Main Function Buttons

Table 2 describes the Main Function buttons located in the bottom left corner of the Main 
Display window. 

3.3 Navigating the Surveillance Area

The Surveillance Area displays a view of Buildings and Floors in two or three dimensions. You 
establish a view in the Surveillance Area by:

• Selecting a building with the Building Selection tool.

• Selecting a floor with the Floor Selection tool.

• Selecting one of the View Options.

You can navigate the Surveillance Area with the pointer, keyboard or touchscreen.

Current User Displays the current user.

List Area Manages all active events. See Chapter 6 on page 96.

Table 2  Main Function button descriptions

Main Function Button Description

Exit Exits OpenGN.

About
Displays the Version number, License Type, copyright information, 
CodeMeter stick License Type information, and company contact 
information.

Login Displays the Login window. See section 3.4 on page 34.

Config. Displays the Configuration window. See section 3.5 on page 36.

The Event Log Displays a printable log report. See section 3.6 on page 41.

Attention: Only users with Technician access or higher can use the Exit and 
Config buttons.!
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To navigate the Surveillance Area with a pointer

To navigate the Surveillance Area with a keyboard

To show the rotation sliders on a touchscreen

• Click Config. > Settings > Display Settings > Show Rotation Sliders.

To navigate the Surveillance Area with a touchscreen

3.3.1 View Option Buttons

Table 3 describes the six View Option buttons located at the top of the Surveillance Area. 

Drag Click and drag the building or floor plan in any direction.

Rotate Right-click as you drag the pointer left or right. (Building/Campus view 
only)

Tilt Right-click as you drag the pointer up or down.
(Building/Campus view)

Zoom Depending on your mouse, there are two zoom methods:

•  Scroll the wheel up or down.

•  Click the middle mouse button and move the mouse up and down.

Reset View Right-click the Surveillance Area, and then select Reset View. (2D View 
only)

Drag Press the arrow keys.

Rotate Hold down the Shift key and press the left and right arrow keys. (Building/
Campus view)

Tilt Hold down the Shift key and press the up and down arrow keys. 
(Building/Campus view)

Zoom Press the + and - keys to zoom in or out.

Reset View Press the Enter key.

Tilt Press the vertical rotation slider.

Navigate 
screen 

Press the screen and drag your finger up, down, left and right.

Rotate Press the horizontal rotation slider in the direction you want to rotate.

Table 3  View Option button descriptions

View Option Button Description

Switches
Displays a visual representation of an annunciator. You can place fire control 
switches here. If it is configured to meet listing agency requirements, then 
you can perform control functions here.

Network View Displays a list of all imported jobs.
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3.3.2 Using the List Area

The List Area displays all active events. 

To quickly acknowledge the event

• Check the corresponding box.

Right-click an event to manage the event. For more information on managing events see 
Chapter 6 on page 96.

Figure 18    List Area

2D View Displays a 2D representation of the selected floor of the selected building.

Building View Displays a 3D representation of the selected building.

Campus View Displays a 3D representation view of all buildings in the selected Campus.

Auto-watch View
Displays a rotating three dimensional campus view of all the buildings and 
floors.

Table 3  View Option button descriptions (Continued)

View Option Button Description

Event List Sorting Tabs

Event

List

Action Buttons and Current User
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Event List Displays a color coded list of active events with the following information:

•  Acknowledge

•  Event ID

•  Event Timestamp

•  Object Description

•  Object Type

•  Event Type

•  Event Description

•  Building

•  Floor

•  Job

•  Device Address

•  Node (optional)

•  CPU (optional)

•  Loop (optional)

Event List Filter Tabs The event list can be filtered to show events of the following types:

•  All

•  Alarm (optional)

•  Supervisory (optional)

•  Trouble (optional)

•  Monitor (optional)

Action Buttons and 
Current User

Contains the Silence\Unsilence, Acknowledge All, Expand\Collapse List 
buttons, and displays the Current User.
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3.3.3 Action Buttons

3.4 Login Window

The Login window lets you switch users or change the password of the current user.

To access the Login window after OpenGN has started

1. Click the Login button in the Main Functions area of the Main Display window (in the 
lower left corner of your screen).

To change the current user

1. Select the user from the menu.

2. Type the password.

3. Click OK.

Figure 19    Login Window

Table 4  Action Buttons

Action Buttons Result

Acknowledge All
Acknowledges all events under the selected sorting tab. The 
alarm tone from the computer stops.

Silence
Silences the alarm tone. This silences only the alarm on 
OpenGN, not the alarm on the Fire Alarm Control Panel.

Unsilence Makes the alarm tone audible, if it was previously silenced.

Expand\Collapse 
List

Expands or collapses the List Area.
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To change the password of the current user

1. Click Change Password. 

The Change Password window appears.

Figure 20    Change Password

2. Type your old password in the Old Password box.

3. Type a password of 16 characters or less in the New Password box.

4. Type the same password into the Re-enter New Password box.

5. Click OK to save the information and return to the Main Display window.

Note: You can change your password only after you have logged into OpenGN.i
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3.5 Configuration Window

The Configuration window is the area where you set up your buildings and floor plans.

To access the Configuration window

1. Click the Config button in the Main Display window.

2. Click OK.

Figure 21    Configuration window

In the Configuration window, there are two different views available: the 2D view of the floors 
and the Campus view. By default, the Configuration window displays the 2D view of the 
selected Floor and Building.

2D View

In the 2D view, you can place objects by dragging them from the Job Tree to the Surveillance
Area. For more information, see Chapter 5 on page 83.

Job 

Tree

Surveillance 

Area

Configuration

Functions

Building 

Selection

Floor 

Selection

Tools

Color and 

Brightness Tool

one and 

ape Tree

2D View Campus View
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Campus View

You can move, rotate, or rescale the Campus View buildings. Use this view to adjust the 
placement and layout of the buildings that are networked together in your fire protection 
system.

The Configuration window has the following parts:

3.5.1 Configuration Function Buttons

The Configuration Function buttons are located in the bottom right hand corner of the 
Configuration window.

To... Do this...

Reposition 
buildings

Click and drag

Enlarge or 
shrink a 
building

Mouse over a building and use the mouse scroll wheel, or click and 
drag the edge of the building

Rotate a 
building

Click and drag the corner of the building

Job Tree Shows all devices appear in the Job Tree in the following hierarchy:
Job > Node > CPU > Loop > Object.

Zone and Shape Tree Lists all zones and the shapes assigned by zone. Unassigned shapes are listed 
in the Unassigned Shapes tree.

Floor Selection Cycles through the floors of the selected building. The first floor in the list 
shows all unplaced objects.

Building Selection Cycles through the buildings in the campus.

Surveillance Area Displays the requested information from the Building Selection, Floor 
Selection in 2D View. Only 2D navigation functions are available on the 
Configuration window Surveillance Area.

Tools Contains the Selection, Text, Icon, Filled Rectangle and Empty Rectangle 
buttons.

Color and Brightness 
Tools

Changes the color of a building or zone. The currently selected color is shown 
in the large box immediately above the group of colors. Use the slider bar to 
change the brightness and opacity.

Configuration 
Functions

Contains the Taskbar, Settings, and Back buttons. For more information see 
Table 5.

Table 5  Configuration Function button descriptions

Configuration Function Button Description

Taskbar Shows the Windows taskbar.
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3.5.2 Tools

The Tool buttons are located in the top right corner of the Configuration window.

Settings

Configures the following settings:

•  Panel Settings

•  Campus Settings

•  Display Settings

•  Icon Settings

•  Object Type Settings

•  Event Log Settings

•  Email Notification Settings

•  Database Settings

•  Connection Settings

•  Users Settings

For more information, see Chapter 4 on page 51.

Back Takes you back to the Main Display window.

Table 6  Tool button descriptions

Tool Button Description

Selection Selects items in the Surveillance Area.

Text
Places new text or edits existing text in the Surveillance Area. You can 
change the color of the text by selecting the desired color in the Color 
and Brightness Tools section.

Add Image Imports and places an image in the Surveillance Area.

Empty 
Rectangle

Lets you draw an empty rectangle that you can assign to a new or 
existing zone. You can change the color of the rectangle by selecting 
the desired color in the Color and Brightness Tools section.

Filled 
Rectangle

Lets you draw a filled rectangle that can you can assign to a new or 
existing zone. You can change the color of the rectangle by selecting 
the desired color in the Color and Brightness Tools section.

Table 5  Configuration Function button descriptions (Continued)

Configuration Function Button Description
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3.5.3 Job Tree

The Job Tree is on the left side of the Configuration window. Click the + and - icons to expand 
and collapse the tree.

Figure 22    Job Tree Hierarchy

The Job Tree hierarchy has the following structure:

Note: All rectangles are filled with color when their associated zone is active. The
Empty Rectangle and the Filled Rectangle tools differ only in how the areas
appear when they are not active.

Job The Job is the top level of the tree and has branches for System 
Status, System Switches and Node directly under it. 

System Status System Statuses are inputs that can be correlated to outputs, LEDs, or 
switches. System Statuses report on the status of the system as a 
whole.

System Switches System Switches are displayed as configured from the panel.

Node A node is a fire panel that monitors and controls through the Base I/O. 
The master panel is always designated by the top level Job. The Node 
has branches for Base I/O, Node Status and any Remote Annunciators 
directly under it.

Base I/O The Base I/O is the CPU inside the fire panel. Each CPU is dedicated 
to processing alarm, audio and LCD annunciation data. Each CPU 
receives data from a Loop. The Base I/O has branches for CPU Status 
and any Loops directly under it.

Node Status Node Statuses are inputs that can be correlated to outputs, LEDs and 
switches. Node Statuses report on the status of the node that they are 
part of.

i
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3.5.4 Zone and Shape Tree

The Zone and Shape Tree is on the left side of the Configuration window below the Job Tree. 
Click the + and - icons to expand and collapse the tree.

Figure 23    Zone and Shape Tree Hierarchy

The Job Tree hierarchy has the following structure:

Remote 
Annunciator

Remote Annunciators are devices that make announcements, for 
instance a speaker or LCD panel.

CPU Status The CPU Status shows the status of the main CPU on the node.

Loop A Loop is a circuit that all addressable devices are on.

Device A device is a fire monitoring unit. The device placement state is shown 
by color.

Green - Device is placed on the floor plan.

Red - Device is not placed on the floor plan.

Gray - Device is not visible on the floor plan.

Note: By default, all devices are visible after importing the job file.

Zones This area contains all the existing zones. Under each zone is a list of all 
shapes and objects assigned to that zone.

Unassigned 
Shapes

This area lists all shapes that are not assigned to Zones. See Chapter 
5 on page 83.

i
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3.6 Using the Event Log

The Event Log records all system events and alarms. The administrator establishes what 
information is shown in the Event Log. For more information on Event Log criteria, see section 
4.9 on page 69.

Figure 24    Event Log

System Status Displays status information such as the connection state and operation progress.

Events Shown This section shows all the events.

•  If there are less than 1 000 events, this area displays Showing Event 1 to end.

•  If there are 1 500 events, then this area displays Showing Event 500 to end.

Log Functions Contains the Back and Print buttons. For more information see Table 7.

Event Log Displays all system events and alarms. For more information, see section 4.9 on 
page 69.

Note: The Event Log is currently not sortable. To print a filtered or sorted list, use the
Print Feature. For more information, see section 3.6.2 on page 42.
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3.6.1 Log Buttons

Table 7 describes the two Log Buttons at the bottom left of the Event Log.

3.6.2 Printing the Event Log Report

You can filter and sort the report before you print it.

To print an Event Log Report

1. Click the Event Log button in the main Display window.

2. Click the Print button.

The Print Event Log Report window appears.

Figure 25    Print Event Log Report window

3. Select the criteria to filter the report. The criteria are listed below. Select as many criteria 
as required.

Table 7  Log button descriptions

Log Button Description

Back Takes you back to the Main Display window.

Print
Opens the Print Event Log Report. For more information, see section 3.6.2 on 
page 42.

Attention: Filtering reports is not in compliance with regulatory agencies.!
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4. Click one of the radio buttons in the Sort By section. This determines how the report is 
sorted. If you click none of the buttons, an unsorted report will be generated.

5. Click Ascending order or Descending order in the Order In section. This determines 
the order of sorting.

6. Click Generate.

The Application Report Viewer Window appears (Figure 26).

Figure 26    Application Report Viewer

Start Date This menu lets you select the first date that you want to filter by.

End Date This menu lets you select the last date that you want to filter by.

Building This menu lets you select the building that you want to filter by. 
In order for OpenGN to filter events by building, devices must be 
placed on the floor plan.

Activation Type Select the desired Activation Types that you want to filter by. If 
you do not select any items, all activation types will be included 
in the report. To remove a filter selection, select the highlighted 
item.

Event Type Select the desired Event Types that you want to filter by. If you 
do not select any items, all event types will be included in the 
report. To remove a filter selection, select the highlighted item.

Device Address Device Address is the address of the object circuit on an 
addressable loop.

Unique ID Unique ID is a unique ID panel address.

Description Description is the label in the Object description column of the 
Events Log. You can type a partial description to find all 
matches. For instance, to find “sprinkler”, type “spr”.

•  Date •  Object Address •  Unique ID

•  Activation Type •  Event Type •  Object Description
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7. Click the Print Report icon.

For more information on the icons see the table below.

Table 8  Application Report Icons

3.7 OpenGN Gateway

Verify with MGC that you have the latest version of the OpenGN Gateway.

You must run the OpenGN Gateway in order for OpenGN to communicate with the Fire Alarm 
Control Panel. The OpenGN Gateway runs on the same computer as OpenGN or on a 
separate computer on the same network. The computer that the OpenGN Gateway is running 
on must be connected to the Fire Alarm Control Panel.

Icon Bar Button

Export Report
Saves the report in a format such as PDF, Word, Excel, Excel Data 
Only, Crystal Reports, or Rich Text Format.

Print Report Prints the report.

First Page Goes to the first page of the report.

Previous Page Goes to the previous page in the report.

Next Page Goes to the next page in the report.

Last Page Goes to the last page in the report.

Close Current View Closes the current view of the report.

Zoom Increases or decreases the magnification.
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To run the OpenGN Gateway

1. Right-click the Open Graphic Navigator Gateway icon, then select Run as 
Administrator.

The OpenGN Gateway appears.

Figure 27    The OpenGN Gateway with 2 adapters

3.7.1 Adapter List

The Adapter List appears when you start the OpenGN Gateway. It contains adapters (saved 
settings).

The Adapter List displays the following information:

To start an adapter

1. Select the adapter that you want to start.

2. Click the green arrow icon. 

To stop an adapter

1. Select the adapter that you want to stop.

Source Type The type of Fire Alarm Control Panel.

Source 
Connection

The IP address and port of the Fire Alarm Control Panel.

Command IP The IP address of the computer that the OpenGN Gateway is installed 
on.

Command Port The port that the OpenGN Gateway communicates through.
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2. Click the red pause icon. 

To edit an adapter

1. Select the adapter that you want to edit.

2. Click the pencil icon. 

3. Follow the instructions under section 3.7.3 on page 47 to edit the settings.

To delete an adapter

1. Select the adapter that you want to delete.

2. Click the X icon. 

3.7.2 About adapters

An adapter is a setting that tells the OpenGN Gateway how to connect to the Fire Alarm 
Control Panel and OpenGN. The OpenGN Gateway must have at least one adapter in the 
Adapter List in order to work. The OpenGN Gateway can run more than one adapter at the 
same time.

An adapter includes the following information:

• Source Type: The type of Fire Alarm Control Panel.

• Connection String: The Fire Alarm Control Panel’s IP address and port.

• Destination: The IP address and port of the computer that OpenGN is on. An adapter 
can have more than one Destination. In this case, one Fire Alarm Control Panel is 
sending information to two or more instances of OpenGN.

• Command Connection and Port: The IP address and port of the computer that the 
OpenGN Gateway is on.
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To see the details of an adapter

1. Double-click the adapter in the Adapter List.

The Adapter Configuration window appears, showing the details for the adapter.

Figure 28 shows the Adapter Configuration window for an adapter that is connected to 
3 instances of OpenGN.

Figure 28    Adapter connected to 3 instances of OpenGN

3.7.3 Adding and editing adapters

To add an adapter

1. In OpenGN, click the + button. 

The Adapter Configuration window appears.

2. Provide the following information:

Type Select the kind of Fire Alarm Control Panel that the OpenGN Gateway 
is connecting to.

Connection String Type the IP address and the port of the Fire Alarm Control Panel, 
separated by a colon.

Source Type 
(type of FACP)

Connection String 
(IP address of the 
FACP)

Destinations 
(OpenGN 
computers)

Command Connection 
(OpenGN Gateway 
computer)
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3. Click the green + button under Destination, and then provide the following information:

4. Click OK.

The Destination appears in the Destination field on the left.

5. Repeat steps 3 and 4 to add more than one destination to an adapter if you want the 
OpenGN Gateway to communicate with more than one instance of OpenGN. For each 
instance of OpenGN, provide a different Destination Port.

6. Under Command Connection, provide the following information:

7. Select Auto Start Adapter When OpenGN Gateway Starts if you want the OpenGN 
Gateway to connect automatically with these settings when it starts.

8. Click Save.

9. Quit the OpenGN Gateway and start it again. See section 3.7.5 below.

To change a Destination

1. In the Destination box, select a Destination, and then click the pencil icon. 

2. Follow step 3 above to edit the Destination.

3. Click OK (or click Cancel to abandon your changes).

To delete a Destination

• In the Destination box, select a Destination, and then click the X icon. 

To connect the adapter

• Click Start.

When it is connected, the light beside Connection String turns from red to green.

3.7.4 Setting the OpenGN Gateway to Run as Administrator

It is helpful to set the OpenGN Gateway to run as administrator. Otherwise, you must right-
click the Open Graphic Navigator Gateway icon and select Run as Administrator every 
time you start it.

Destination IP The IP address of the computer that OpenGN is installed on.

Destination Port 1209

Store and Forward 
Events

Reserved for future use.

Incoming 
Command IP

The IP address of the computer that the OpenGN Gateway is on.

Port 1309. This must be a different port than the port listed above.
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To set the OpenGN Gateway to run as administrator

1. Right-click the Open Graphic Navigator Gateway icon and select Properties.

2. Click the Compatibility tab.

3. Select Run this program as an administrator.

4. Click OK.

3.7.5 Quitting and Restarting the OpenGN Gateway

You must quit and restart the OpenGN Gateway whenever you make changes.

To quit and restart OpenGN Gateway

1. In the Windows taskbar, right-click the OpenGN Gateway icon, and then select Close 
window.

Figure 29    Close OpenGN Gateway

2. Start the OpenGN Gateway.

3.7.6 Starting and stopping adapters

To start an adapter

1. In OpenGN, select the adapter that you want to start.
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2. Click the green arrow icon. 

To stop an adapter

1. In OpenGN, select the adapter that you want to stop.

2. Click the red pause icon. 

3.7.7 The colors show the adapter status

The adapters in the Adapter List change color to show whether they are connected.

• White: The adapter is not connected.

• Green: The adapter is connected to both the panel and OpenGN.

• Red: The adapter is attempting to connect to either the panel or OpenGN.

• Orange: The adapter is not connected to all instances of OpenGN (when it is configured 
to connect to more than one instance).
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4.0  Configuration Settings
This chapter provides an overview of the configuration settings of OpenGN.

This chapter covers

• Panel Settings

• Campus Settings

• Display Settings

• Icon Settings

• Object Type Settings

• Event Log Settings

• Email Notification Settings

• Database Settings

• Connection Settings

• User Settings

• Localization
LT-1113 Rev 3.4.1 51 (139)



Configuration Settings
4.1  Opening the Configuration Settings

1. Click the Config button from the Main Display window, and then click Yes to confirm that 
you want to enter the configuration section.

The Configuration window appears. See Figure 21 on page 36.

2. Click the Settings button in the lower right-hand corner of the Configuration window.

4.2 Panel Settings

The Panel Settings window

• Selects a Fire Alarm Control Panel from the list of loaded configurations.

• Displays the Details for the selected panel.

• Imports a job file from the Configurator.

NOTICE TO USERS, INSTALLERS, AUTHORITIES HAVING JURISDICTION, AND OTHER INVOLVED PARTIES

This product incorporates field-programmable software. In order for the product to comply with the 
requirements in the Standard for Control Units and Accessories for Fire Alarm Systems, UL 864, certain 
programming features or options must be limited to specific values or not used at all as indicated below.

Program feature or 
option

Permitted in UL 864? 
(Y/N)

Possible settings\methods
Settings permitted in 
UL 864

Filterable Report 
Generation

NO

Filter report by Date, 
Activation Type, Event Type, 
Node, CPU, Loop, Object 
Address, Unique ID, 
Description

All events must be 
reported. Filtering is 
not permitted.

Display Mode YES
Dual Monitor, Graphics and 
List, Graphics Only, List Only

Dual Monitor, 
Graphics and List

Supervision Mode YES
Supervised Mode, Non-
Supervised Mode

Supervised Mode

Attention: Do not open the Settings window while OpenGN is connected to a 
panel.!
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Figure 30    Panel Settings

4.2.1 Selecting a Fire Alarm Control Panel to View its Details

• Click the Select Panel menu, and then choose a previously imported Fire Panel.

4.2.2 Deleting a Panel

You can delete a panel configuration that you no longer need.

To delete a panel

1. Click the Panel Settings tab (see Figure 30).

2. Select the panel from the Select Panel menu.

3. Click Delete.

4. Click Yes in the pop up confirmation window.
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4.2.3 Panel Details

4.2.4 Importing the Job File

OpenGN uses the job file to create a Job Tree that matches the job on the Fire Alarm Control 
Panel. When importing the job file, the object icon images may be associated with the default 
images.

To import the job file

1. In the Main Program Settings window, click the Panel Settings tab.

The Panel Settings window appears (see Figure 30 on page 53).

2. Click Browse in the Panel Configuration section, and then navigate to the job file.

3. Select Auto-associate default icons if you want to associate the objects with the 
default icons.

4. Click Import XML.

Panel Guid and 
Version Guid

Each job has a Panel GUID (also called the Job Unique ID) and 
Version GUID (also called Job Version) that uniquely identifies it. 
These numbers are generated by the Configurator or the XML 
conversion tool, depending on the type of panel.

Because OpenGN can manage more than one job, it must associate 
every event it receives with the correct job. Every event that is sent to 
OpenGN contains the Panel GUID and Version GUID, and OpenGN 
uses this information to determine which job the event belongs to.

If OpenGN receives an event with an unknown Panel GUID, OpenGN 
generates an Unknown Panel Event System Message.

If OpenGN receives an event with a known Panel GUID but an 
unknown Version GUID, OpenGN generates a Version GUID 
Mismatch System Message.

For more information see about status messages, see Appendix B on 
page 105.

Manufacturer The name of the Fire Alarm Control Panel manufacturer.

Description A brief description of the Fire Alarm Control Panel.

Model The name that the manufacturer has assigned to this model of Fire 
Alarm Control Panel.

Panel URL A link to the Fire Alarm Control Panel manufacturer’s website.

Job Type Reserved for future use.

Filename The location of the job file on the computer.

Note: If the job on the Fire Alarm Control Panel changes, you must export the job file 
from the Configurator, and then import it into OpenGN again.i
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If the job already exists, a window appears asking you if you want to update the stored
version of the job with the one you are importing.

• Click Yes.

Figure 31    Update Job Confirmation Box

A message appears saying that the import was successful.

5. Click Close.

4.3 Campus Settings

The Campus Settings window is where the administrator:

• Enters the Campus Information. The Campus Contact Person and Phone Number will 
appear in email messages if email notification is configured (see section 4.10 on 
page 71).

• Names each Building that is a part of the Campus.

• Constructs the visual representation of buildings by importing image files of floor plans.

Figure 32    Campus Settings
LT-1113 Rev 3.4.1 55 (139)



Configuration Settings
4.3.1 Supported Floor Plan File Formats

OpenGN supports the following image file formats for importing floor plans. Table 9 shows 
them in the order of their recommended use.

After you import the floor plans, you can arrange object icons on specific locations on the floor 
plan. For more information on objects, see Chapter 5 on page 83.

Attention: MGC recommends not uploading any files larger than 25 MB.

Table 9  Supported Floor Plan File Formats

Supported File Type Description

SVG
This is a vector based file format that ensures the quality of the drawings 
will not change regardless of the Zoom setting.

4 channel PNG (RGBA)
This includes alpha transparency. Floor plans will be transparent, enabling 
you to view all floors of a building at the same time without obstruction.

3 channel PNG (RGB) 
JPG
BMP 
GIF

These formats do not support transparency. OpenGN will convert white 
color to transparency.

Note: For a description on how to convert PDF files to SVG, see Appendix H on 
page 128.

!

i
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4.3.2 Adding a Campus Plan

A campus is a collection of buildings. You must create a campus before you create buildings.

To add a Campus Plan

1. Click Update Campus Plan in the Campus Settings window (Figure 32 on page 55).

The Campus Plan Properties window appears.

Figure 33    Campus Plan Properties

2. Click Select Campus Plan.

3. Browse to the new Campus Plan image file, select it, and then click Open.

4. Click OK to save the information and return to the Campus Settings window.

5. Type the information for your campus in the Campus Information section.

4.3.3 Updating the Campus Logo

You can change or update the logo for your campus.

To update the Campus Logo

1. Click Change Campus Logo in the Campus Settings window (Figure 32 on page 55).

2. Browse to the file location and click Open.

4.3.4 Adding a Building

A building consists of one or more floors, each of which has a floor plan. You must create a 
building before you can add floor plans.

To add a building

1. Click the Config button from the Main Display window, and then click Yes to go to the 
configuration section.

The Configuration window appears.

Note: If you have one building, you still need to import a campus plan.i
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2. Click Settings > Campus Settings.

The Campus Settings window appears (see Figure 32 on page 55).

3. In the Buildings area, click New.

The Building Properties window appears.

Figure 34    Enter your New Building Properties

4. Type a name for the building.

5. Click OK.

4.3.5 Placing a Building on the Campus

You can move and resize buildings on the campus map.

• Click the Campus View button  at the top of the Configuration window.

By default, the building you just added is in the center of the campus.

• Click and drag a building to move it on the campus.

• Click and drag the edge of a building to change its size.

• Click and drag the corner of a building to rotate it.

Note: Only the top 6 buildings are visible in the Campus View. However, all the 
buildings are visible in Surveillance mode. To place more than 6 buildings, see 
Appendix F on page 116.i
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4.4 Modifying and Deleting a Building

To modify a building

1. In the Buildings area, select the building that you want to modify.

2. Click Modify.

The Building Properties window appears.

Figure 35    Modify Your Existing Building

3. Type a name for the building.

4. Click OK.

To delete a building

1. In the Buildings area, select the building that you want to delete.

2. Click Delete.

3. Click Yes.

4.4.1 Adding a Floor Plan

After you have added a building, you can assign a floor plan to each floor.

To add a floor plan

1. Click New in the floor plan area.

The Floor Properties window appears.

Figure 36    Enter your new floor properties
LT-1113 Rev 3.4.1 59 (139)



Configuration Settings
2. Provide the following floor property information:

3. Click Select Floor Plan, then browse to the file location, and then click Open.

A preview image of the floor plan appears.

4. Click OK.

See Chapter 5 on page 83 for instructions on how to configure and place objects on a floor 
plan.

4.5 Modifying and Deleting a Floor

To modify a floor plan

1. In the Buildings area, select the floor that you want to modify.

2. Click Modify.

The Building Properties window appears.

Figure 37    Modify your Existing Floor Properties

Description A description of the floor.

Translate X Reserved for future use.

Translate Y Reserved for future use.

Width Reserved for future use.

Height Reserved for future use.

Scale Reserved for future use.
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3. Provide the following floor property information:

4. Click Select Floor Plan, then browse to the file location, and then click Open.

A preview image of the floor plan appears.

5. Click OK.

To delete a floor

1. In the Buildings area, select the floor that you want to delete.

2. Click Delete.

3. Click Yes.

4.6 Display Settings

You can configure how the Surveillance and List Areas appear in the Main Display window.

To configure the Display Settings

1. Click the Config button from the Main Display window, and then click Yes to go to the 
Configuration section.

The Configuration window appears.

Description A description of the floor.

Translate X Reserved for future use.

Translate Y Reserved for future use.

Width Reserved for future use.

Height Reserved for future use.

Scale Reserved for future use.
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2. Click Settings > Display Settings.

The Display Settings window appears (Figure 38).

Figure 38    Display Settings

3. To determine how you want the display settings to appear, select from the following 
display mode parameters:

Attention: The UL Lock checkbox must be selected for UL / ULC compliance. It 
prevents the user from switching OpenGN to the background.

Note: The Instance menu is reserved for future use.

Dual Monitor Allows for dual monitor support.

Graphics and list Shows both the Graphics and List areas.

Graphics only Shows only the Graphics area.

List only Shows only the List area.

Attention: To comply with UL 864 Rev.9, use only Dual Monitor or Graphics and 
List.

!
i
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4. To determine how you want the display options to appear, enter the following 
parameters:

5. To select the supervision mode, choose from one of the following parameters:

6. Click Close.

4.7 Icon Settings

OpenGN has a pre-made set of customizable object icons. You can modify or add to these 
icons.

4.7.1 Creating a New Icon

You can create new icons and associate them with objects.

Default View Specifies the default view as one of the following:

•  2D View

•  3D View

•  Campus View

Auto-watch Interval Specifies the interval of time for each building to display.

Screensaver Timeout Reserved for future use.

Start auto-watch on startup Enables the auto-watch feature on startup.

Play Sounds Specifies if an audible tone sounds when an event 
occurs.

Show Rotation Sliders On a touchscreen display, shows the rotation sliders, 
which you use to modify the viewing angle of the 
Surveillance Area.

Enable Screen Saver Reserved for future use.

Note: If the Start auto-watch on startup checkbox is selected, then Campus View is 
the only choice allowed as the default view.

Supervised Requires you to manually acknowledge all problems 
and restore events.

Non-Supervised Automatically acknowledges events when the problem 
is restored.

Attention: To comply with UL 864 Rev.9, use Supervised mode.

i
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To create a new icon

1. Click the Config button from the Main Display window, and then click Yes to go to the 
configuration section.

The Configuration window appears.

2. Click Settings > Icon Settings.

The Icon Settings window appears (Figure 39).

Figure 39    Icon Settings

3. Select the Invert preview background check box to preview an inverted color 
background of a selected icon.

4. Click New.

The Icon Properties window appears.

Figure 40    Enter your New Icon Properties

5. Click Select Icon, and then choose an image. The selected file can have an extension of 
PNG, ICO, BMP, JPG, JPEG, or GIF.

6. Type a description of the icon in the Description field.
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7. Select Invert preview background if you want to preview an inverted color image of the 
selected icon.

8. Click OK to apply the settings and exit the Icon Properties window.

9. Click Close from the Icon Settings window to apply the settings.

4.7.2 Modifying an Existing Icon

You can modify existing icons.

To modify an existing icon

1. Click the Config button from the Main Display window, and then click Yes to go to the 
configuration section.

The Configuration window appears.

2. Click Settings > Icon Settings.

The Icon Settings window appears (see Figure 39 on page 64).

3. Select Invert preview background to preview an inverted color background of a 
selected icon.

4. Select an icon from the list of available icons.

Figure 41    Icon Selection

5. Click Modify.
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The Icon Properties window appears.

Figure 42    Modify your existing icon properties

6. Click Select Icon, and then choose an image. The selected file can have an extension of 
PNG, ICO, BMP, JPG, JPEG, or GIF.

7. Type a description of the icon in the Description field.

8. Select Invert preview background if you want to preview an inverted color image of the 
selected icon.

9. Click OK.

10. Click Close.

4.7.3 Deleting an Existing Icon

You can delete icons that you no longer need.

To delete an existing icon

1. Click the Config button from the Main Display window, and then click Yes to go to the 
configuration section.

The Configuration window appears.

2. Click Settings > Icon Settings.

The Icon Settings window appears (see Figure 39 on page 64).

3. Select Invert preview background to preview an inverted color background of a 
selected icon.

4. Select an icon from the list of available icons (see Figure 41 on page 65).

5. Click Delete.
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The Icon Delete Confirmation window appears.

Figure 43    Icon Delete Confirmation

6. Click Yes to delete the selected icon.

7. Click Close.

4.8 Object Type Settings

An object type is a type of device, for instance a smoke detector or a phone. The list of object 
types ranges from ion detectors to heat sensors, with each object having a corresponding 
category:

You can associate a different icon with each state of an object. For example, you can give a 
heat detector three icons: an icon for its normal state, an icon for its alarm state, and an icon 
for its trouble state. When it goes into alarm, its icon on the floor plan changes from its normal 
state icon to its alarm state icon.

Several common object types (for instance smoke detectors and phones) have default icons. 
For a complete list of object types, see Appendix E on page 113.

The default icon for an unknown object type is a question mark.

OpenGN displays images of every placed object on the map area, color coded according to its 
configuration. When an event occurs, the object becomes active and concentric rings appear 
around its icon in the Surveillance area.

To discover a device’s object type

• Hover the pointer over the device’s icon on the floor plan.

Detector Indicates that the object is a smoke, heat, or fire detector.

Module Indicates that the object is a control or input device, such as a manual 
station or a water flow switch.

Other Indicates that the Detector or Module categories do not apply.
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In the window that appears, the object type corresponds to the Device Type. In Figure 
44, the Device Type, and therefore the object type, is Firephone Ipt.

Figure 44    Object Info Message

4.8.1 Associating an Icon with an Object State

The Object Type Settings window has a list of object types.

To associate icons with states

1. Click the Config button in the Main Display window, and then click Yes to go to the 
configuration section.

The Configuration window appears.

2. Click Settings > Object Type Settings.

The Object Type Settings window appears (Figure 45).

Figure 45    Object Type Settings

3. Select an object type in the Select Object Type list.
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4. Click a state in the Select Object State menu.

5. Select the appropriate icon for this state in the Select Icon list.

6. Select Invert preview background if you want to invert the icon color background.

7. Click Close.

8. Restart OpenGN.

4.9 Event Log Settings

OpenGN records all events and alarms, but you can select specific criteria for display in the 
Event Log.

The Event Log displays all recorded alarms and events that meet the search criteria entered in 
the Event Log Settings window. The data fields in the Event Log are listed by column 
according to the defined search criteria.

Clicking the Event Log button on the Main Display window opens the Event Log. For more 
information about the Event Log see Chapter 6 on page 96.

4.9.1 Configuring Event Log Settings

The Event Log displays many types of information. This section shows you how to choose 
what you want to see in the Event List.

Note: When importing the Job file with the Auto-associate default icon option 
selected, object type and the corresponding icon are associated.

You must restart OpenGN for the icon changes to take affect.
i
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To configure Event Log settings

1. Click the Config. button from the Main Display window, and then click Yes to confirm 
that you want to enter the configuration section.

The Configuration window appears.

2. Click Settings > Event Log Settings.

The Event Log Settings window appears (Figure 46)

Figure 46    Event Log Settings

3. Select the check box beside the criteria you want to have appear in the Event Log.

To select all of the Event Log categories, click Select All.

To de-select all of the categories click Clear:

Event ID Every system event receives a unique identifier.

Panel Time Stamp Every fire panel has its own clock.

OpenGN Time 
Stamp

OpenGN uses the PC clock to set its time.

Activation Type Activation or Restoration of an event.

Event Type The type of event; Active, Trouble or Bypass.

Event Description An event based description.

Object Type The type of object that triggered the event.

Object Class The family of objects an object belongs to, like Input Circuit or 
System Status Flag.

Object Description An object based description.

Object Address The loop address of the object that triggered the event.

Campus The campus where the event occurred.
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4. Click Close.

4.10 Email Notification Settings

OpenGN can send event notifications to a designated email address. In order to use email 
notification, you must have access to an SMTP server that does not use SSL. Emails are sent 
from info@OpenGN.com.

4.10.1 Configuring Email Messages

To configure email messages

1. Click the Config. button from the Main Display window, and then click Yes to confirm 
that you want to enter the configuration section.

The Configuration window appears.

2. Click Settings 

3. Click the Email Notification Settings tab.

Building The building where the event occurred.

Floor The floor where the event occurred.

Job The name and configuration of the master panel.

Other Node, CPU, and Loop location of the Object that triggered the 
event.

Unique ID The unique ID panel address.

User Displays the user that acknowledge the event. 

Raw XML Displays the raw XML data associated with the event.

Attention: For ULC S527 and UL 864 applications, email notification is an ancillary 
feature.i
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The Email Notification Settings window appears (Figure 47)

Figure 47    Email Notification Settings

4. Click the Enable e-mail notification checkbox.

5. Provide the following information:

6. Click Campus Settings on the left and ensure that the Campus Contact Person and 
Phone Number are correct. (See section 4.3 on page 55.) This information will appear 

Note: In order to use email notification, you must have access to an SMTP server that 
does not use SSL.

E-mail server Type the SMTP server’s IP address or domain name. The 
SMTP server must not use SSL.
If you need assistance, ask your network administrator.

SMTP Port Type the port for the SMTP server. If you need assistance, 
ask your network administrator.

To E-mail Address Type the email address to send notifications to.

You can enter more than one email address. Separate the 
addresses with commas. For example, if you want to send 
notifications to sarah@email.com, tegan@email.com and 
jo@email.com, then type:

sarah@email.com,tegan@email.com,jo@email.com

There is a maximum of 100 characters in this field, including 
commas.

Note: The Requires user authentication, E-mail user name, and E-mail password 
options are reserved for future use.

i

i
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in the email message in the form “Please contact Campus Contact Person at Phone 
Number if you need further assistance.”

7. Click Close.

4.10.2 Viewing Email Messages

Email messages are colored depending on the Object Configuration:

• Alarm - red

• Supervisory - orange

• Trouble - yellow

• Monitor - blue

• Restore events - green

Figure 48    Example Email Message

4.11 Database Settings

The database contains user, Job and system log information, and can be saved to a specified 
location.

4.11.1 Setting Database Information

Database Settings lets you define the backup location for the Job, system messages and 
object configuration.

4.11.2 Backing up Database Information

You can back up the database to preserve old configurations in case they are needed again 
later. This is especially useful to do before you make any changes to the configuration.

Note: Backing up the database regularly is recommended.i
LT-1113 Rev 3.4.1 73 (139)



Configuration Settings
To backup database information

1. Click the Config. button from the Main Display window, and then click Yes to confirm 
that you want to enter the configuration section.

The Configuration window appears.

2. Click Settings > Database Settings.

The Database Settings window appears (Figure 49)

Figure 49    Database Settings

3. Click Browse in the Backup Folder Location section, and then navigate to the location 
where you want to store the database backup.

4. In the Save As window, type a name for the backup, for instance OpenGN backup.

Figure 50    Choose a backup location and name

Note: The backup folder cannot be on the Desktop or in a user’s folder.
Make a folder on the root drive of the computer and store the backups there.i
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5. Click Backup to create the backup file of the current database.

6. Click Close to save the settings and return to the Configuration window.

4.11.3 Restoring Database Information

The following procedure shows how to restore a database.

To restore database information

1. Click the Config. button from the Main Display window, and then click Yes to confirm 
that you want to enter the configuration section.

The Configuration window appears.

2. Click Settings > Database Settings.

The Database Settings window appears (Figure 49 on page 74)

3. Browse to the location where you stored the backup and select it.

4. Click Restore to restore the database.

5. Quit OpenGN and restart it.

4.12 Connection Settings

The Connection Settings show the TCP/IP connection details.

4.12.1 Viewing the Connection Settings

To view the Connection Settings

1. Click the Config. button from the Main Display window, and then click Yes to confirm 
that you want to enter the configuration section.

The Configuration window appears.

2. Click Settings > Connection Settings.

The Connection Settings window appears (Figure 51):

Figure 51    Connection Settings
LT-1113 Rev 3.4.1 75 (139)



Configuration Settings
Event Host Web Service Details and DB Connection Details are reserved for future use.

4.12.2 TCP/IP

In an Ethernet based network, OpenGN and the OpenGN Gateway use the TCP/IP protocol to 
communicate.

A successful Ethernet based connection shows the following TCP/IP parameters:

4.13 User Settings

User Settings lets you create and manage User Groups and Users. Access Privileges are 
granted to User Groups and Users derive their rights from the Group they are assigned to.

4.13.1 Viewing User Groups and Users 

The User Settings window lets you view and modify the User Groups and Users that exist in 
the system.

To view user groups and users

1. Click the Config. button from the Main Display window, and then click Yes to confirm 
that you want to enter the configuration section.

The Configuration window appears.

2. Click Settings > User Settings.

The User Settings window appears (Figure 52)

Figure 52    User Settings

IP Address IP address of the computer OpenGN is on.

TCP/IP Port 1209. This is the TCP/IP port that OpenGN uses.

Subnet Mask Subnet mask address of the network server.

Default Gateway Default gateway address of the network server.
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4.13.2 Managing User Groups and Assigning Group Privileges

You can create New User Groups, and Modify or Delete existing User Groups. OpenGN has 
three default user Groups: Administrator, Technician, and Concierge.

4.13.3 Creating a new User Group

You create new groups to allow users specialized access for jobs that do not fit the definitions 
of existing groups.

To create a new User Group

1. In the User Group section click New. The User Group window appears.

Figure 53    Enter your New User Group Privileges

2. Enter the Group Name.

3. Select the appropriate checkboxes for the Group Privileges that are essential to the 
functions of this group.

Acknowledge Alarm Allows the members of the User Group to acknowledge 
alarms.

Print Log Allows the members of the User Group to use the Print Log 
functions.

Send Command Allows the members of the User Group to use control 
functions.

Access OpenGN Config Allows the members of the User Group to access the Config 
section. Note that this Privilege is required as a prerequisite 
to the “Access OpenGN Setting” Privilege.

Access OpenGN Setting Allows the members of the User Group to use the 
Configuration Settings section. Note that this Privilege is 
required as a prerequisite to any of the other “Setting” 
privileges.

Access Panel Setting Allows the members of the User Group to access 
Configuration Settings > Panel Settings.
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4. Click OK to create the User Group.

4.13.4 Modifying an Existing User Group

You can add or delete some privileges from certain groups.

Access Campus Setting Allows the members of the User Group to access 
Configuration Settings > Campus Settings.

Access Display Setting Allows the members of the User Group to access 
Configuration Settings > Display Settings.

Access Icon Setting Allows the members of the User Group to access 
Configuration Settings > Icon Settings.

Access Device Type Setting Allows the members of the User Group to access 
Configuration Settings > Object Type Settings.

Note that Object Setting was previously Device Setting 
and this checkbox allows access to Object Setting even 
though the checkbox label is out of date.

Access Event Log Setting Allows the members of the User Group to access 
Configuration Settings > Event Log Settings.

Access Email Setting Allows the members of the User Group to access 
Configuration Settings > Email Settings.

Access Database Setting Allows the members of the User Group to access 
Configuration Settings > Database Settings.

Access Connection Setting Allows the members of the User Group to access 
Configuration Settings > Connection Settings.

Access User Setting Allows the members of the User Group to access 
Configuration Settings > User Settings.

Receive Notification Email Reserved for future use.

Acknowledge All Events Allows the members of the User Group to Acknowledge All 
Events.

Manual Event Restore Allows the members of the User Group to manually restore 
events.

Exit OpenGN Allows the members of the User Group to exit OpenGN.

Note: The Administrator User Group cannot be modified.i
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To modify an existing User Group

1. In the User Group section select the desired User Group, and then click Modify.

The User Group window appears showing the current Group Privileges. 

Figure 54    Modify your existing User Group Privileges

2. Check or uncheck the desired Privileges to add or remove rights from the user Group.

3. Click OK.

4.13.5 Deleting an Existing User Group

You can delete a User Group that is longer required.

To delete an existing User Group

1. In the User Group section, select the desired User Group, and then click Delete.

2.  A confirmation window appears asking if you are sure that you want to delete the groups 
selected and all dependent users.

3. Click Yes.

4.13.6 Managing Users

You can create New Users, and Modify or Delete existing Users.

4.13.7 Creating a new User

You can create User accounts for new employees with all the right privileges to allow them to 
do their job while ensuring site security.
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To create a new User

1. In the User Group section click New. The User Details window appears.

Figure 55    Enter your new User Details

2. Complete the following fields:

3. Click OK to create the new User.

4.13.8 Modifying an Existing User

When employee information changes, you can modify the User’s information and privileges to 
reflect the changes.

To modify an existing User

1. In the Users section select the desired User, and then click Modify.

•  User Full Name 
(mandatory)

•  Address •  Telephone

•  Email •  Job Title
•  User Group 

(mandatory)

•  Login (mandatory) •  Password (mandatory)
•  Confirm Password 

(mandatory)

•  User Photo
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The User Details window appears showing the current information about this User.

Figure 56    Modify your Existing User Details

2. Change the current entries as needed.

3. Click OK.

4.13.9 Deleting an Existing User

You can delete users when they leave or move to a division where they no longer require 
access to OpenGN.

To delete an existing User

1. In the Users section select the desired User click Delete.

2. A confirmation window pops up asking if you are sure that you that to delete the selected 
user.

3. Click Yes.

4.13.10 Inactivity Timer User

For security, OpenGN can be set to switch to a different user account after a certain period of 
mouse or keyboard inactivity. In this way, if the computer is unattended, the administrator 
privileges of OpenGN are not available.

Note: This feature works only when the main display window is active. It does not work 
when the Configuration or Settings windows are active.i
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To set the inactivity timer

1. Create a new user as described in section 4.13.7 and assign this user to the Technician 
or Concierge group, or to a custom group.

2. Under Inactivity Timer User, select Use auto user switch.

3. In the switch user to menu, select a user.

4. Enter a number of seconds after when OpenGN will switch to that user.

5. Click Close.

To log back into the Administrator account

• Click the Login button and switch to the administrator user as described in section 
3.4 on page 34.

4.14 Localization

OpenGN is available in English and French.

To change the language

1. Quit OpenGN.

2. In Windows, navigate to the directory where OpenGN is installed. By default this is:
C:\Program Files (x86)\Mircom Group of Companies\Open Graphic Navigator

3. Double-click the opengn.ini file.

4. On the Language line, change the two-letter code to en for English or fr for French.

Figure 57    Language

5. Close and save the file.

6. Start OpenGN.

Note: This user cannot be in the Administrator group and should have restricted 
privileges.

Note: Some information from the panel is not localized. For example, the 3 last 
columns in the List Area (Node, CPU, and Loop) will remain in English when 
OpenGN is configured for French. Trouble and alarm messages from the panel 
may also remain in English.

Non-Roman characters in the job file may not display properly in OpenGN.

i

i
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5.0  Configuring Objects and Zones
Adding objects to floor plans lets you observe real-time events in the Surveillance Area. You 
can label and define objects and zones, and you can add emergency instructions.

This chapter covers

• Configuring Objects and Zones

• Configuring Objects in the Job Tree

• Configuring Objects in the Surveillance Area

• Configuring Zones

• Working with the Zone and Shape Tree

• Unplaced Objects Screen
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5.1 Configuring Objects and Zones

Objects are all the fire objects, system statuses and switches connected to the Fire Alarm 
system. OpenGN assigns properties to objects to help define them, monitor, and control them.

A zone is an area that contains related objects.

You configure objects and zones in the Job Tree and the Surveillance Area of the 
Configuration window. For a general overview of the Configuration window, see section 3.5 on 
page 36.

5.2 Configuring Objects in the Job Tree

Right-click an object in the Job Tree to see the following menu:

Figure 58    Fire Object Options

Go to Fire Object Finds a placed or unplaced object.

Place Selected Fire 
Objects

Adds an object to the floor plan. Unplaced objects are red in the 
job tree, and placed objects are green.

Remove Selected 
Fire Object 
Placements

Removes any object from the floor plan.

Modify Fire Object 
Description

Modifies the description.

Modify Fire Object 
Take Action Message

Modifies the Take Action message. This message describes the 
actions you need to take when an event occurs.

Set Visible  Makes invisible objects visible on the floor plan.
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5.2.1 Go to Fire Object

This option shows the object on the floor plan.

To find an object

1. Double-click the object in the Job Tree.

Or

1. Right-click the object in the Job Tree.

2. Choose Go to Fire Object from the menu.

The object appears in the center of the Surveillance Area and is surrounded with a red 
square.

Figure 59    Go to Fire Object

3. Place the pointer over the object to display the object message.

Figure 60    Object Info Message

Set Invisible Makes the object invisible on the floor plan.

Description Editing 
Mode

Lets you rename multiple objects at once.

Show Invisible Items Shows all the invisible objects in the Job Tree. Invisible objects 
are gray in the Job Tree.

Show Placed Items Reserved for future use.
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5.2.2 Placing and Removing Objects

Adding objects to a map provides you with an accurate visual representation of the 
surveillance Area and allows you to effectively monitor the location. Unplaced objects are red 
in the Job Tree, and placed objects are green. When OpenGN is connected to the Fire Alarm 
Control Panel, all objects show alarm events whether they are on the floor plan or not.

To place objects

1. Select the building and floor plan where you want to add the objects.

2. Right-click an object in the Job Tree, and then click Place Selected Fire Objects.

The object appears at the top of the Map Area.

3. Drag the object to a location on the floor plan.

To remove objects

1. Right-click an object in the Job Tree, and then click Remove Fire Object.

The object disappears from the floor plan.

5.2.3 Modify Fire Object Description

Every object has a description.

To define or change an object description

1. Right-click an object in the Job Tree, and then click Modify Fire Object Description.

2. Type a unique description for the object.

5.2.4 Description Editing Mode

You can rename multiple objects at once.

Note: It is the customer’s responsibility to ensure that the objects are placed accurately
on the floor plan.i
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To enter Description Editing Mode

1. Right-click an object in the Job Tree, and then click Description Editing Mode.

2. Select an object in the Job Tree, then type a description.

3. When you are finished editing object descriptions, right-click in the Job Tree, and then 
uncheck Description Editing Mode.

Figure 61    Description Editing Mode

5.2.5 Modify Fire Object Take Action Message

Every object has a Take Action Message.

To enter or change a Take Action Message

1. Right-click an object in the Job Tree, and then click Modify Fire Object Take Action 
Message.

The Take Action Message window appears.

Figure 62    Take Action Message

2. Type the instructions that the operator needs to take when this object is active.

3. Click OK.
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5.2.6 Set Visible or Invisible

By default, all objects are visible. You can make an object invisible on the floor plan, Job tree 
or both. Invisible objects are gray in the Job Tree.

To make an object invisible

• Right-click an object in the Job Tree, and then click Set Invisible.

The object becomes invisible on the floor plan and in the Job Tree.

5.2.7 Show Invisible Items

Show Invisible Items shows the invisible objects in the Job tree. They are gray.

To show an invisible object in the Job Tree

• Right-click in the Job Tree, and then click Show Invisible Items.

The invisible objects become visible in the Job Tree. They remain invisible on the floor 
plan.

To hide an invisible object in the Job Tree

• Right-click in the Job Tree, and then uncheck Show Invisible Items.

All invisible objects on the floor plan become hidden on the Job Tree.

5.3 Configuring Objects in the Surveillance Area

To move an object on the floor plan

• Click and drag an object in the Surveillance Area to move it to another location on the 
same floor.

Note: Invisibility does not change alarm and event notification.i
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• Right-click an object in the Surveillance Area to see the following menu:

Figure 63    Commands for Objects in the Surveillance Area

5.3.1 Modify Description

Every object has a description.

To enter or change an object description

1. Right-click an object, and then click Modify Description.

The Modify Description window appears.

Figure 64    Modify Description

2. Type a unique description for the object.

3. Click OK.

5.4 Configuring Zones

Zones are areas that contain related objects and shapes. The Zone and Shape Tree lists all 
configured Zones and the objects in them, as well as all unassigned shapes.

Resize Move the pointer to change the size of the object icon. Click to finish 
sizing the icon.

Reset Size Resets the icon back to its default size.

Remove Removes the icon from the floor plan. For instructions on placing 
objects, see section 5.2.2 on page 86.

Modify 
Description

Modifies the description. For instructions see section 5.2.3 on page 86.

Add to Zone Opens the Zone Properties window. For more information on working 
with zones, see section 5.4.1 on page 90.
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5.4.1 Adding Objects to Zones

To add an object to a zone

1. Right-click an object in the Surveillance Area, and then click Add to Zone.

The Zone Properties window appears.

2. Click either Existing Zone or New Zone.

• If you chose an Existing Zone, click the menu, and then click the Zone.

• If you chose a New Zone, type the name of the zone in the Description field.

3. Click OK.

The object appears under the appropriate Zone in the Zone and Shape Tree.

5.4.2 Drawing Shapes

You can draw rectangles on the floor plan to represent fire zones. You can make more than 
one rectangle part of the same zone. If an event occurs on any object in a zone, the entire 
zone will change to the appropriate event color.

Use the Tool buttons and the Color and Brightness buttons to draw shapes.

The Tool buttons are located in the top right corner of the Configuration window (Figure 21 on 
page 36).

The Color and Brightness buttons are located in the bottom right corner of the Configuration 
window.

Table 10  Tool button descriptions

Tool Button Description

Selection Selects items in the Surveillance Area.

Text
Places new text or edits existing text in the Surveillance Area. You can 
change the color of the text by selecting the desired color in the Color 
and Brightness Tools section.

Add Image Imports and places an image in the Surveillance Area.

Empty 
Rectangle

Lets you draw an empty rectangle that you can assign to a new or 
existing zone. You can change the color of the rectangle by selecting 
the desired color in the Color and Brightness Tools section.

Filled 
Rectangle

Lets you draw a filled rectangle that can you can assign to a new or 
existing zone. You can change the color of the rectangle by selecting 
the desired color in the Color and Brightness Tools section.
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To draw a shape

1. In the Configuration window, use the Color and Brightness tool to set the color you want 
the new rectangle to be. See Figure 21 on page 36.

2. Click the Empty or Filled Rectangle tool. See Table 10.

3. Click in the Surveillance Area where you want the first corner of the rectangle to be.

4. Drag the pointer to create a rectangle.

5. Click again to finish drawing the rectangle.

You can resize, move, and change the color of the rectangle after you draw it.

To resize a shape

1. Select the Selection tool. It looks like an arrow (see Table 10).

2. Hover the pointer inside one of the side sections of the rectangle so that the pointer 
changes to the Resize Tool Icon.

Figure 65    Resize Tool Pointer Icon

3. Click and drag the pointer to lengthen or shorten the rectangle.

4. To change the height of the rectangle, move the pointer to the upper or lower side 
section and drag the pointer.

Note: All rectangles are filled with color when their associated zone is active. The
Empty Rectangle and the Filled Rectangle tools differ only in how the areas
appear when they are not active.

Note: You can also resize a rectangle with the mouse wheel. Moving the mouse wheel
shrinks or expands the rectangle proportionally.

i

i
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To move a shape

1. Select the Selection tool. It looks like an arrow (see Table 10).

2. Hover the pointer over the middle of the rectangle so that the pointer icon changes to the 
Move Tool Icon.

Figure 66    Move Tool Icon

3. Click and drag the pointer.

To rotate a shape

1. Select the Selection tool. It looks like an arrow (see Table 10).

2. Hover the pointer over the corner of the rectangle so that the pointer icon changes to the 
Rotate Tool Icon.

Figure 67    Rotate Tool Icon

3. Click and drag the pointer.
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5.4.3 Assigning Shapes to Zones

After you create a shape, it has a default description and is not part of a zone. Hover the 
pointer over the shape to show the description in the top left corner of the shape.

Figure 68    A New Shape

Right-click a shapes in the Surveillance Area to see this menu:

To assign a shape to a zone

1. Right-click a shape in the Surveillance Area, and then click Assign to Zone.

The Zone Properties window appears.

2. Click either Existing Zone or New Zone.

• If you chose an Existing Zone, click the menu, and then click the Zone.

• If you chose a New Zone, type the name of the zone in the Description field.

3. Click OK.

The shape appears under the appropriate zone in the Zone and Shape tree.

5.5 Working with the Zone and Shape Tree

There are four types of items in the Zone and Shape Tree. The item types are:

• Zones

• Assigned Objects

• Assigned Shapes

• Unassigned Shapes

Modify 
Description

Modifies the description. For instructions see section 5.3.1 on 
page 89.

Assign to Zone Opens the Zone Properties window. For more information on working 
with zones see section 5.4 on page 89.

Delete Deletes the shape.
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5.5.1 Zones

• Right-click a zone to see this menu:

5.5.2 Assigned Objects

• Right-click an object that is part of a zone to see this menu:

5.5.3 Assigned Shapes

• Right-click a shape that is part of a zone to see this menu:

5.5.4 Unassigned Shapes

• Right-click a shape that is not part of a zone to see this menu:

Modify Description Modifies the description. For instructions see section 5.3.1 on page 89.

Delete Zone Deletes the zone. Any shapes or objects will be disassociated with the 
zone.

Go to Fire Object The object appears in the center of the Surveillance Area.

Move to zone Moves the object to a different zone. 

Add to zone Adds the object to another zone. The object now has duplicate entries 
in the Zone Tree.

Remove from this 
zone

Removes the object from the zone.

Go to Shape The shape appears in the center of the Surveillance Area.

Modify Description Modifies the description. For instructions see section 5.3.1 on page 89.

Assign to Zone Opens the Zone Properties window. For more information on working 
with zones see section 5.4 on page 89.

Un-assign from this 
zone

Removes the shape from the zone.

Delete Deletes the shape.

Go to Shape The shape appears in the center of the Surveillance Area.

Modify Description Modifies the description. For instructions see section 5.3.1 on page 89.

Assign to Zone Opens the Zone Properties window. For more information on working 
with zones see section 5.4 on page 89.

Delete Deletes the shape.
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5.6 Unplaced Objects Screen

• Click the first floor of the Floor Selection frame to see all unplaced objects.

Figure 69    Unplaced Objects

The Unplaced Objects screen displays all unplaced devices.

Figure 70    Unplaced Objects Screen
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6.0  Managing Events
This chapter provides information for the operator on how to monitor system events and 
alarms.

This chapter covers

• Monitoring Events and Alarms

• What to do When an Event Occurs

• Using the Control Functions
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6.1 Monitoring Events and Alarms

OpenGN displays images of every object on the map area, with the correct location of the 
object in buildings and on floors, and each object color coded according to its status and state. 
When OpenGN receives an alarm notice, it emits a tone and a displays an visual indication to 
show the alarm and trouble conditions.

Figure 71    Object Alarm

6.1.1 Object States

An object state is its current status. Objects have four states:

For instructions on how to associate object states with icons, see section 4.8 on page 67.

6.1.2 Object Functions

You can configure objects for the following functions:

Color coded messages indicate the status and configuration of each object.

Normal By default, objects in normal mode are green and not animated.

Trouble Objects reporting trouble have animated yellow rings.

Active Active Objects are animated with concentric rings in their default 
configuration display colors.

•  Alarm - red

•  Supervisory - orange

•  Trouble - yellow

•  Monitor - blue

Bypass Bypassed objects are yellow.

•  Alarm Input •  Trouble Input •  Monitor Input

•  Supervisory Input
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6.1.3 List Area

The List Area (see Figure 17 on page 29) displays all events and alarms and their search 
criteria. The search criteria are listed by column according to the following categories:

6.2 What to do When an Event Occurs

When an event occurs, the following things happen:

• The Surveillance Area enters 2D view and zooms to the object that is causing the event.

• The object becomes animated with the appropriate colored concentric circles.

• The System Status area displays the appropriate message.

• The event is displayed on the Event List and is added to the Event Log.

• The Settings button on the Configuration window is disabled.

Figure 72    Active Events

When an event occurs, you can do the following things:

• View the object info.

• Go to the object.

• Acknowledge the event.

• View the Take Action message.

• Restore the event.

•  Acknowledged •  Event Type •  Object Address

•  Event ID •  Event Description •  Node (optional)

•  Event Timestamp •  Building •  CPU (optional)

•  Object Description •  Floor •  Loop (optional)

•  Object Type •  Job
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6.2.1 View the Object Info

• The Object Info appears in the Event List. If you hover the pointer over the object, the 
object info appears.

6.2.2 Go to the Object

1. Right-click the object in the Event List.

2. Click Go to.

OpenGN zooms to the floor where the object is.

6.2.3 Acknowledge the Event

When you acknowledge an event, the object stops flashing on the floor plan, and the event 
stops flashing in the Event List. Acknowledging affects OpenGN only; nothing changes on the 
panel.

There are two ways to acknowledge events.

• Select the corresponding checkbox in the Ack column.

• Click the Ack All button to acknowledge all events.

6.2.4 Acknowledge Restore Events

OpenGN displays a green restore event to indicate that the panel has restored an alarm, 
supervisory, or trouble. In Supervised mode (section 4.6 on page 61), you must acknowledge 
restore events. In Non-Supervised mode (section 4.6 on page 61), OpenGN acknowledges 
restore events automatically.

When a restore event is acknowledged either by the technician or by OpenGN, both the 
restore event and the event disappear from the event list.

6.2.5 View the Take Action Message

There are two ways to view the Take Action Message.

• Double-click the object in the Surveillance area.

• Right-click the object in the Event List, and then click Take Action Message.

6.2.6 Restoring the Event

When you restore an event, it disappears from the event list. Restoring affects OpenGN only; 
nothing changes on the panel.

• Right-click the object in the Event List, and then click Restore.
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6.3 Using the Control Functions

The Switches View button in the Surveillance area (see section 3.3.1 on page 31) shows a 
grid where you can place annunciator switches. You can control the panel from here if the 
authority having jurisdiction allows it.

For example, you can place a Acknowledge switch in the Switches View, so that the operator 
can send an acknowledge command to the Fire Alarm Control Panel.

6.3.1 Supported Control Functions

To set up control functions

1. Go to Configuration Settings, and navigate to Control Switches in the Floor Selection.

2. In the Job Tree, expand the System Switches section.

3. Drag a system switch from the Job Tree to the Control Switches grid.

To use control functions

1. In the Surveillance Area, click the Switches View button.

2. Click a switch to send that command to the panel.

3. Click Yes in the window that appears.

Note: The control functions of OpenGN Phase II have not been submitted to UL for 
certification. You may want to use control functions during testing, or when the 
system is in maintenance mode when there are qualified personnel present. 
However, if you require OpenGN to control the Fire Alarm Control Panel during 
normal operation, use the fully listed OpenGN Phase I.

Table 11  Supported Control Functions

Model FleX-NetTM MR-2900 MR-2200 PRO-2000 FX-2000

Firmware version 12.1.9

11.11.9

11.10.9

22.12 22.11 5.14 2.14

Acknowledge X X X

Signal Silence X X X

System Reset X X X X

Fire Drill X

Bypass X X X

Manual Evacuation X

i
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6.3.2 Bypassing Objects

You can bypass an object in OpenGN. OpenGN sends a signal to the Fire Alarm Control Panel 
to bypass the object. The corresponding device will be shown as bypassed on the Fire Alarm 
Control Panel.

To bypass an object

• Right-click the object, and then select Bypass.

To unbypass an object

• Right-click the object, and then select Unbypass.
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Appendix A - Computer 
Configuration
This chapter describes some suggested Windows settings which will help OpenGN run 
smoothly.

Set the computer to never go to sleep

1. Click Start, click Control Panel, then click Power Options.

2. Beside the plan you are using, click Change plan settings.

3. Select Never for Turn off the display, and Never for Put the computer to sleep.

Figure 73    Power Options
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4. Click Change advanced power settings.

5. Click the plus sign beside Hard disk, then Turn off hard disk after.

6. Click the arrow to change the setting to Never. This setting ensures that the hard disk 
will never turn off.

Figure 74    Power Options - Hard disk

7. Select Sleep, then Sleep after, and change the setting to Never.

8. Under Hibernate after, change the setting to Never. These settings ensure that the 
computer will never go to sleep.

Figure 75    Power Options - Sleep
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9. Under Display, change the setting to Never. This setting ensures that the display will 
never turn off.

Figure 76    Power Options - Display

10. Click OK, then click Save changes.

Use the Windows 7 Basic Appearance

1. In the Control Panel, click Personalization, then click Personalization.

2. Select Windows 7 Basic.

Figure 77    Personalization
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Appendix B - System Messages
System messages provide information about the connection settings and panel status.

Connection and Panel Status Messages

Table 12 lists the Connection and Panel Status messages that appear in the Status Area and 
are listed by the order in which OpenGN checks them.

For complete descriptions of the Status Message see Table 13.

Status Message Descriptions

Table 13 contains images and complete descriptions of each possible Status Message. The 
status messages are listed in alphabetical order.

Table 12  Status Message Type

Status Message Status Message Type

Disconnected Connection Status

No Jobs Imported Connection Status

Alarm Active Panel Status

Supervisory Panel Status

Trouble Panel Status

Monitor Panel Status

Version Guid Mismatch Connection Status

Unknown Panel Events Connection Status

Unknown Heart Beat Connection Status

System Normal Panel Status and Connection Status

Table 13  Connection and Panel Status Messages

Status Message Image Status Message Description

Alarm Active

The Alarm Active message appears when a fire alarm is 
initiated by high priority designated objects, such as, 
smoke detectors, ion detectors, heat detectors, sprinkler 
flow switches, manual stations and other objects 
configured to detect fire.
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Disconnected

The Disconnected message indicates that the panel is 
disconnected from the system. This message appears 
when at least one Job is imported and the job file is not 
received from the OpenGN Gateway.

In addition to this message, an alert appears in the Event 
List.

Monitor Active

The Monitor message is initiated from panels containing 
this function by lower priority designated objects such as 
telephones. The fire department or monitoring company is 
not notified.

No Panels Imported

This message appears when there is no imported job file.

Supervisory Active

The Supervisory message indicates that a component of 
the fire detection system is disabled due to a manual error, 
such as a closed fire sprinkler valve or active tamper 
switch. Objects designated as a lower priority can also 
trigger a Supervisory alarm.

System Normal

Once connection is established, both Job Unique ID and 
Job Version are identified, The job file is imported and 
there are no alarms. The system is normal.

Table 13  Connection and Panel Status Messages (Continued)

Status Message Image Status Message Description
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Trouble Active

The Trouble message indicates that a fault or defect exists 
on the panel, such as a panel electrical problem, 
malfunctioning or disabled smoke detector, a disabled or 
disconnected zone, backup battery low power, ground 
faults, or short or open circuits.

Unknown Heartbeat

The panel sends a packet of data to the OpenGN 
Gateway on a periodic basis. This packet of data is called 
the heartbeat. OpenGN compares the heartbeat to the 
information in the database.

An Unknown Heartbeat message indicates that panel 
sending the message may not exist in the database.

Unknown Panel Event

This message appears when the Panel GUID does not 
match the version in the OpenGN database. This 
message requires a physical connection and a successful 
job file import in order to appear.

Version Guid Mismatch

This message appears when the Version GUID does not 
match the version in the OpenGN database. This 
message requires a physical connection, a successful job 
file import and valid Panel GUID in order to appear.

Table 13  Connection and Panel Status Messages (Continued)

Status Message Image Status Message Description
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Appendix C - Network Topologies
Figure 78 shows the various ways that OpenGN can be connected.

A FleX-NetTM system can be connected to the OpenGN Gateway computer directly or through 
a switch. If if is connected directly, then it must be connected to a dedicated network interface 
card (NIC) on the OpenGN Gateway computer. In Figure 78, the OpenGN Gateway computer 

has 4 network interface cards because it is connected directly to 3 FleX-NetTM systems, and it 
is also connected to a switch.

The primary OpenGN can be run on the same computer as the OpenGN Gateway, or on a 
different computer.

Figure 78 Networking OpenGN
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Appendix D - Monitoring Instances
The instructions below describe how to set up a second instance of OpenGN as shown in 
Figure 78 on page 108. These instructions assume that you have already configured the first 
instance of OpenGN and the OpenGN Gateway as described in Chapter 3 on page 36.

To set up a monitoring instance

1. Install OpenGN on a computer on the same network as the first instance of OpenGN as 
described in chapter 2.

2. In the Choose Setup Type window, click Custom.

Figure 79    Choose Setup Type

3. Double-click OpenGN.

Figure 80    Custom Setup
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4. Click the menu beside OpenGN Gateway, then select Entire feature will be 
unavailable.

5. Click Next.

Figure 81    Custom Setup

6. After you install OpenGN, import the job file into OpenGN as described in the document 
specific to your panel:

• LT-6620 OpenGN to PRO-2000 Connection Instructions

• LT-6055 OpenGN to MR-2200/2900 Connection Instructions

• LT-6622 OpenGN to FleX-NetTM Connection Instructions

• LT-1105 OpenGN to FX-2000 Connection Instructions

Note: Each instance of OpenGN requires the same job file, and a Codemeter USB key 
connected to the computer.i
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To configure the OpenGN Gateway with the monitoring instance

1. In the OpenGN Gateway window, Click the + button. 

The Adapter Configuration window appears.

Figure 82 OpenGN Gateway Connected to 3 Instances of OpenGN

2. Click the green + button  under Destination and provide the following information for 
the second instance of OpenGN:

Figure 83 Destination

Destination IP The IP address of the computer that the second instance of 
OpenGN is installed on.

Destination Port 1209

Store and Forward 
Events

Reserved for future use.

Source Type 
(type of FACP)

Connection String 
(IP address of the 
FACP)

Destinations 
(OpenGN 
computers)

Command Connection 
(OpenGN Gateway 
computer)
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3. Click OK.

The Destination appears in the Destination field on the left.

4. Click Save at the bottom of the Adapter Configuration window.

5. In the Windows taskbar, right-click the Open Graphic Navigator Gateway icon, and 
then select Close window.

Figure 84 Close Open Graphic Navigator Gateway

6. Right-click the Open Graphic Navigator Gateway icon, then select Run as 
Administrator.
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Appendix E - Input Object and 
Assorted Status Types

Input Object Types

Table 14 lists the various types of input objects. This list is not exhaustive.

Table 14   Input Object Types

Object Icons

The following figure shows the object icons bundled with OpenGN.

Figure 85 Object Icons

•  Default •  Fire Phone Input •  Conventional Relay

•  Ion Input •  Addressable Output Signal •  Conventional Phone

•  Photo Input •  Relay Driving Signal •  Voice Line

•  Heat Input •  Relay •  Amplifier

•  Input Module •  Conventional Alarm Input •  Remote Switch

•  Laser Input •  Conventional Output Signal •  Addressable Relay

•  Acclimate Input •  Conventional Relay Driving 
Signal
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Job Status Types (for FleX-Net™ panels only)

Table 15 lists the various Job Status types.

Table 15   Job Status Types

Node Status (for FleX-Net™ panels only)

Table 16 lists the various Node Status types.

Table 16   Node Status Types

•  Alarm Ack •  Common Trouble •  Sig Sil Inhibit

•  Alarm Xmit Active •  Evac Active •  Sig Silence Pulse

•  Alert Active •  Fire Drill •  Signal Silence

•  All Call •  Ground Fault •  Signals Active

•  All Call Minus •  Latched Relays •  Silenceable Opts Act

•  Alm Buzzer •  New Alarm Active •  Spv Buzzer

•  Alm Buzzer Silence •  Off Hours •  Spv Buzzer Silence

•  Amp Trouble •  Page by Phone •  Subsequent Alarm

•  Auto Day/Night •  Page to Alert •  Sys Reset

•  Auto Ga Timing •  Page Inhibit •  Sys Reset Inactive

•  Auto SS Timing •  Page to Evac •  Telephone Call in

•  Auto Suite Resound •  Page Ready •  Telephone Call In Silenced

•  Aux Disc •  Paging Active •  Telephone Trouble

•  Aux Reset Pulse •  Page by Phone •  Total Evacuation

•  Common Alarm •  Pre-Alarm Active •  Trb Buzzer

•  Common Monitor •  Pre-Tone Active •  Trb Buzzer Silence

•  Common Supv •  Relay Auto Test Act •  Trouble Xmit Active

•  AC On •  Node Ground Fault •  Node Sys Reset Active

•  Alm Relay Active •  Node Maint. Alert •  Node Tel Call In

•  Audible Walktest •  Node Monitor •  Node Trbl Xmit Active

•  Microphone Trouble •  Node Pre-alarm •  Node Trouble

•  Node Active •  Node Relay Auto Test •  Node Wflw Retard

•  Node Alarm •  Node PTT Pressed •  Page Ready

•  Node Alarm Verif •  Node Signal Silence •  Pre-Tone Active

•  Node Alert Active •  Node Signals Active •  Silent Walktest

•  Node Amp Trouble •  Node Subsequent Alarm •  Spv Relay Active

•  Node Call Control •  Node Supv •  Trb Relay Active

•  Node Evac Active
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Me
Connection Status Conditions

Table 17 shows the conditions that generate system messages.

Table 17   Connection Status Conditions

Conditions

Job file 
Successfully 

imported

Physical 
Connection 
established

Panel GUID 
Validated

Version GUID 
Validated

ssage

Disconnected Yes No N/A N/A

No Panels Imported No No N/A N/A

Version GUID Mismatch Yes Yes Yes No

Unknown Panel Events N/A Yes No N/A

Unknown Heart Beat N/A Yes No N/A

System Normal Yes Yes Yes Yes
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Appendix F - Troubleshooting FAQ

 Frequently Asked Questions

Q: How do I back up the database?

A: Follow the instructions in section 4.11.2 on page 73 to back up the database.

Backing up the database regularly is recommended.

Q: How do I resynchronize OpenGN if the system goes down?

A: If the panel goes down or if OpenGN quits unexpectedly, follow these instructions.

1. Close OpenGN if it is open.

2. Close the OpenGN Gateway.

3. Restart the computer.

4. Restart the OpenGN Gateway.

5. Restart OpenGN.

6. Perform a network restart on the panel.

OpenGN should reconnect to the panel and receive any events that the panel sent 
while OpenGN was down.

Q: Why is the text on the screen jumbled?

A: This is a known issue with some Intel graphics cards. Update your drivers to solve 
this issue. 

Q: Why does my installation fail and I receive this message?

A: Click the Details button. If you see the message Administrator permissions are 
required, install the application using a user profile that has Administrator rights.
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Q: When I attempt to run OpenGN why do I receive the following message?

A: Ensure that you are running OpenGN with Administrator rights.

Q: Why is OpenGN telling me that I only have a Demo version when I have purchased a 
licensed version? 

A: Ensure that your CodeMeter USB key has been programmed and is connected to the 
computer running OpenGN.

Q: How do I place more than 6 buildings?

A: Only the top 6 buildings are visible in the Campus View. However, all the buildings are 
visible in Surveillance mode. If you have more than 6 buildings, follow these 
instructions.

1. In Campus View in the Configuration window, place and size the visible 
buildings as desired.

2. Click Settings, and then click Campus Settings.

3. In the Buildings section, select the building at the bottom of the list, and then 

click the Up arrow  to move the selected building to the top of the list.

4. Click Close.

5. Click the Campus View button  at the top of the Configuration window.

The building that you moved is now visible.

6. Move and resize the new building as desired.

7. Repeat steps 2 to 6 for each building after the 6th building.

Q: OpenGN does not start.

A: Follow the instructions in Appendix I - Installing and Uninstalling OpenGN on 
page 131 to restore the database from a backup.
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Appendix G - Importing a Revised 
CAD Drawing
If the CAD drawings for your floor plans change, you can import revised CAD drawings into
OpenGN.

1 Import the new CAD drawing into DraftSight

To download and install the latest version of DraftSight

1. Open a web browser and go to 
http://www.3ds.com/products-services/draftsight-cad-software/free-download/

2. Click Download.

3. After the download, run and complete the install application.

To import the drawing into DraftSight

1. In DraftSight, click File > Open and open the original CAD drawing.

2. Click File > Open and open the new CAD drawing into the original CAD file.

Figure 86 New and Old CAD Drawings

Attention: These instructions should be completed by someone familiar with CAD 
software.!
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3. Click Format > Layer.

4. Unselect the layers in the new CAD drawing that you do not want to show in OpenGN.

Figure 87 Hide layers

2 Align the new drawing with the original drawing

1. Select the original CAD drawing, then right-click and select Entity Group > Quick 
Group.

Figure 88 Entity Group
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2. Right-click the new CAD drawing, and select Cut.

3. Paste the new CAD drawing on top of the original drawing, making sure that the new 
drawing has the same coordinates as the original drawing.

Figure 89 New Drawing on Top of Old Drawing

4. Select the original drawing, and press the Delete key.

The new CAD drawing should now have the same coordinates as the original drawing.

Figure 90 New Drawing
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3 Remove the non-essential objects

1. Enable the layers that were previously hidden.

Figure 91 Show Layers

2. Delete the non-essential objects.

Figure 92 Non-Essential Objects
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3. Double click the mouse wheel to automatically display the file to the outer drawing limits.

4. Make sure that all non-essential objects have been removed. Any objects not removed 
may affect the overall drawing scale.

5. Select File > Export > Export.

Figure 93 Export

6. Change the file type to Scalable Vector Graphics Format (SVG).

7. Click Save.

Figure 94 Save as Scalable Vector Graphics Format (SVG)

4 Remove the background and border in Inkscape

The instructions in this section are for cosmetic purposes and are not required.

Inkscape is an Open Source vector graphics editor, with capabilities similar to Illustrator,
CorelDraw, or Xara X, using the scalable vector graphics (SVG) file format.
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To download and install the latest version of Inkscape

1. Open a web browser and go to www.inkscape.org.

2. Click Download Now.

3. After the download, run and complete the install application.

To remove the background and border in Inkscape

1. In Inkscape, click File > Import and import the SVG file.

Figure 95 Inkscape Import
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2. Click File > Document Properties.

The Document Properties window appears.

Figure 96 Document Properties
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Importing a Revised CAD Drawing
3. Unselect Show page border.

4. Close the Document Properties window.

5. Select the Zoom to fit drawing in window icon.

Figure 97 Zoom to Fit Drawing in Window

6. Select the black background near the corner so that the arrow icons appears at the 
corners as shown in Figure 98.

Figure 98 Select the Black Background Near the Corner
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Importing a Revised CAD Drawing
7. Press the Delete key to remove the background.

The SVG file should now have no background.

8. Select File > Save As, and save the file in Plain SVG format.

Figure 99 Save in Plain SVG format

5 Import the SVG file into OpenGN

1. In OpenGN, click the Config button from the Main Display window, and then click Yes to 
go to the configuration section.

2. Click Settings > Campus Settings.

3. Select the floor plan that you want to change.

4. Click Modify.

Figure 100 OpenGN Campus Settings
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Importing a Revised CAD Drawing
5. Click Select Floor Plan, and select the new SVG file.

Figure 101 Floor Properties

6. Click OK.

OpenGN restarts.

7. Ensure that previous device placements have not changed, and modify any object 
placements that may have shifted with the floor plan update.
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Appendix H - Converting PDF files 
to SVG files
OpenGN works best with SVG (scalable vector graphics) files. To convert PDF files to SVG file 
format, MGC recommends using either of the following applications:

• Inkscape 

• Adobe Illustrator

Using Inkscape

Inkscape is an Open Source vector graphics editor, with capabilities similar to Illustrator, 
CorelDraw, or Xara X, using the W3C standard Scalable Vector Graphics (SVG) file format. 

To download and install the latest stable version of Inkscape

1. Open a web browser and go to www.inkscape.org.

2. Click Download Now.

Figure 102 Download Inkscape

3. After the download, run and complete the install application.

To convert a PDF file to SVG format using Inkscape

1. Start Inkscape.

2. Click File > Open.

Figure 103 Inkscape File > Open
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3. Browse to the desired file and click Open. 

The PDF Import window appears.

Figure 104 Inkscape PDF Import Settings

4. If the PDF has multiple pages, select the desired page from the Select page section.

The page will be previewed on the right side of the window. 

5. Click OK. 

The file opens in Inkscape.

6. Click File > Save As. 

The “Select file to save to” window opens.

Figure 105 Inkscape File > Save As
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7. Enter the desired name of the file. Ensure that Save as type is either Inkscape SVG 
(*.svg) or Plain SVG (*.svg). 

8. Click Save.

The file is now ready for import into OpenGN.

Figure 106 Inkscape - Select file to save to

Note: You should generally choose to save your file from Inkscape as Plain SVG. The 
Inkscape SVG format is slightly larger and the only benefit is that you can re-edit 
the file in Inkscape. Also, there is a slight chance of compatibility issues with the 
enhanced format.

i
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Appendix I - Installing and 
Uninstalling OpenGN

Installing only OpenGN or only the OpenGN Gateway

1. Follow the instructions in section 2.4 on page 16.

2. When you see the Choose Setup Type window, click Custom.

Figure 107    Choose Setup Type

3. Double-click OpenGN.

Figure 108    Custom Setup

4. If you want to install OpenGN only without the OpenGN Gateway:

a. Click the menu beside OpenGN Gateway, then select Entire feature will be 
unavailable.
LT-1113 Rev 3.4.1 131 (139)



Installing and Uninstalling OpenGN
b. Click Next.

Figure 109    Custom Setup

5. If you want to install the OpenGN Gateway without OpenGN:

a. Click the menu beside OpenGN Client, then select Entire feature will be 
unavailable.

b. Click Next.

Figure 110    Custom Setup

6. Continue with the installation as described in section 2.4 on page 16.
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Uninstalling OpenGN and its Components

1. From the Windows Start menu, click Start > Control Panel.

2. Double-click Programs and Features. 

3. Click MGC OpenGN, and then click Remove.

The uninstallation takes a few seconds.

Restoring the Database from a Backup

If OpenGN does not start, and you have a backup of the database (see section 4.11.2 on 
page 73), you can restore the database.

To restore the database

1. Quit OpenGN and the OpenGN Gateway.

2. In Windows, click Start, then type cmd in the Search box, then press Enter.

The command prompt appears.

3. Type the following command, and then press Enter.

sqlcmd -S .\SQLEXPRESS

The 1> prompt appears.

4. Type the following command, and then press Enter.

RESTORE DATABASE opengn FROM DISK="PATH_TO_RESTORE_FILE.BAK" 
WITH RECOVERY, REPLACE

For PATH_TO_RESTORE_FILE.BAK, type the full path of the backup database file that 
you want to restore, with the .BAK extension. Type the double quotation marks as they 
appear above.

For example, if the full path of the backup database file is:

H:\OpenGN Backups\OpenGN backup.bak

Then type:

RESTORE DATABASE opengn FROM DISK="H:\OpenGN Backups\OpenGN 
backup.bak" WITH RECOVERY, REPLACE

The 2> prompt appears.

5. Type the following command, and then press Enter.

GO

If the restore was successful, the message RESTORE DATABASE successfully 
processed appears.

6. Type exit and then press Enter to return to the command prompt.

7. Start OpenGN and the OpenGN Gateway.

Note: The database, which contains user, job and system log information, is not 
removed when OpenGN is uninstalled.i
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Agency Listed Specifications

Appendix J - Agency Listed 
Specifications

Requirements

To meet agency requirements the use of OpenGN must adhere to the following:

• Operated with an UL864 9th Edition/ULC-S527 Approved workstation. Testing has been 
done with a COMARK All-In-One QM57 Computer.

• For ULC, using OpenGN as Supervising station (Main Instance of the OpenGN 
program) the COMARK QM57 must be installed in a Rittal KS1454.500 Industrial 
Control Panel Enclosure in the same room and directly connected via ethernet in 
conduit within 20ft to an FACP.

• If being used as a Remote Annunciator (Remote Instance of the OpenGN program) the 
COMARK QM57 must be installed in a Rittal KS1454.500 Industrial Control Panel 
Enclosure.

• Ethernet connection must be supervised in configuration software as shown in Figure 
111.

Figure 111 FleX-Net™ Configurator Set to Supervise Ethernet Connection

Notes:   FACP System configuration cannot be changed via OpenGN.i
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Appendix K - Mounting Instructions

Mounting the COMARK All-In-One QM57 Computer into a Rittal 
KS1454.500 Industrial Control Panel Enclosure

To mount the COMARK All-In-One QM57 Computer

1. Mount the KS1454.500 enclosure as per manufacturers instruction.

2. Wire the electrical box as per local electrical code.

3. Place the COMARK QM57 computer in the KS1454.500 enclosure.

4. Using the #8 screw holes in the bottom plate of the COMARK QM57, carefully mark drill 
holes on the bottom of the KS1454.500 enclosure with a permanent marker.

5. Remove the COMARK QM57 computer from the KS1454.500 enclosure and drill the 
marked holes.

8. Place the COMARK QM57 computer into the KS1454.500 enclosure. From the bottom 
of the KS1454.500 enclosure screw three #8 screws into the drilled holes. Secure the 
screws using three #8 nuts.

6. Plug the power brick supplied with the COMARK QM57 computer into the electrical box.

Figure 112 Rittal Enclosure (Door not Displayed)

Rittal KS 1454500 Enclosure

Electrical Box
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